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CAUTION!

AFT xStream is a sophisticated gas transient modeling program
designed for qualified engineers with experience in transient analysis
and should not be used by untrained individuals. AFT xStream is
intended solely as an aide for pipe flow analysis engineers and not as a
replacement for other design and analysis methods, including hand
calculations and sound engineering judgment. All data generated by
AFT xStream should be independently verified with other engineering
methods.

AFT xStream is designed to be used only by persons who possess a
level of knowledge consistent with that obtained in an undergraduate
engineering course in the analysis of pipe system fluid mechanics and is
familiar with standard industry practice in transient analysis.

AFT xStream is intended to be used only within the boundaries of its
engineering assumptions. The user should consult the AFT xStream
Help System for a discussion of all engineering assumptions made by
AFT xStream.

Information in this document is subject to change without notice. No part of this Quick
Start Guide may be reproduced or transmitted in any form or by any means, electronic or
mechanical, for any purpose, without the express written permission of Applied Flow
Technology.

© 2022 Applied Flow Technology Corporation. All rights reserved.
Printed in the United States of America.
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CHAPTER 1

Introducing AFT xStream

Welcome to AFT xStream™, Applied Flow Technology's powerful gas
transient modeling tool. With AFT xStream you can model transients
caused by a wide range of pipe system behavior. This tool will allow
you to understand transient pressure extremes.

AFT xStream includes a steady-state solution engine which solves for
the system's initial conditions. These results are used to assist with
initializing the transient model. The engineer accesses these capabilities
through an advanced graphical interface, which includes built-in
expertise to guide the engineer through the modeling process.

AFT xStream has one available add-on module which extends AFT
xStream's modeling capabilities into new areas.

e The Pulsation Frequency Analysis (PFA) module allows the
engineer to determine resonant frequencies that can result in
excessive vibration and damage to systems.

Modeling capabilities

AFT xStream provides a broad array of features to model pipe system
transients. These include:

e Transients in open and closed (recirculating) systems
e Network systems that branch or loop
e Systems with valve transients

e Systems with compressor transients
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e Systems that experience sonic choking, including multiple sonic
choking points and transient sonic choking

e Multiple design cases in a single model file

Add-on module capabilities (optional)
e Identification of natural acoustic frequencies (PFA module)

e Evaluation of pressure results with API-618

The steady-state solver

Before a transient model can be run, the initial steady-state conditions
are required. AFT xStream obtains the steady-state solution using
multiple stages. First, the solver from AFT Arrow™, AFT’s steady state
compressible flow modeling software, is used to calculate the steady
solution to initialize the second stage.

Second, the transient solver is run with user-specified transients
disabled. The AFT Arrow solver will typically have slight differences
from the transient solver, and the transient solver must be run to find a
new steady solution to avoid introducing artificial transients into the
transient analysis. This solution is run in a series of time step blocks.
After each block, the velocity results from the beginning and end of the
block are compared to determine if the results are sufficiently steady.

If desired, AFT xStream can be run in “AFT Arrow Steady” mode
where only the steady flow pipe pneumatics are modeled. When run in
"Transient” mode, the steady flow solution is used to assist with
initializing the transient solution. This convenience helps the user avoid
the often error-prone process of manually setting up the initial
conditions, ensures the solution is steady before the transients are run,
and allows the user to quickly and safely modify and rerun the model as
needed.

The transient solver

AFT xStream employs the Method of Characteristics (MOC) to solve
the transient equations of gas flow. The fundamental mass, momentum,
and energy equations are solved at all computing stations in each pipe to
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accurately represent the propagation of transient waves throughout the
system.

The MOC is an explicit solution technique, where the transient solver
marches in time for a duration specified by the user.

Thermophysical property data

AFT xStream derives physical properties from one of four sources. The
first is the standard AFT xStream set of compressible fluids which
contains data for 28 common fluids (called the AFT Standard library).

The second is steam data from the ASME Steam Tables library.

The third is the NIST REFPROP library. REFPROP is licensed from the
National Institute of Standards. REFPROP has a library of
approximately 150 fluids and supports user specified fluid mixtures.

The fourth is the Chempak™ library. Chempak is licensed from
Madison Technical Software and is offered as an optional add-on to
AFT xStream. Chempak has a library of approximately 584 gasses and
supports user specified fluid mixtures. AFT xStream is restricted to non-
reacting mixture calculations.

Engineering assumptions in AFT xStream

AFT xStream is based on the following fundamental fluid mechanics
assumptions:

e Superheated gas flow only (no two-phase flow)
e One-dimensional flow
e No chemical reactions

e The pipes are rigid

AFT xStream Primary Windows

AFT xStream has five windows that work in an integrated fashion. Each
is located on a separate, movable tab. You work exclusively from one of
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these windows at all times. For this reason, they are referred to as
Primary Windows.

Of the five Primary Windows, two are input windows, two are output
windows, and one displays both input and output information. Figure 1.1
shows the relationships between the Primary Windows.

|—~ Model Data »= Visual Report
/

Graph Results

Y

Workspace - Output

Figure 1.1 Primary Window workflow in AFT xStream

Input windows

The two windows that primarily function as input windows are the
Workspace window and the Model Data window. These two windows,
one graphical and the other text based, work together to process model
input data with immense flexibility. The tools provided in these two
windows allow you to model a large variety of pipe networks.

The Visual Report window can function in support of both input and
output data. As an input window, it allows you to see the input data
superimposed on the pipe system schematic created on the Workspace.

Output windows

The two windows that function exclusively as output windows are the
Output window (text based) and the Graph Results window. These two
windows offer a powerful and diverse range of features for reviewing
analysis results for modeling errors, gaining a deeper understanding of
the pipe system's flow behavior, and preparing the results for
documentation.

As an output window, Visual Report allows you to see the output results
superimposed on the pipe system schematic created on the Workspace.
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Note: AFT xStream supports multiple monitors. You can click and drag
any of the five Primary Window tabs off of the main AFT xStream
window. Once you drag one of the Primary Windows off of the AFT
xStream window, you can move it anywhere you like on your screen,
including onto a second monitor in a dual monitor configuration. To add
the Primary Window back to the main AFT xStream Primary Window
tab bar, simply click the X button in the upper right of the Primary
Window.




6 AFT xStream™ 2 Quick Start Guide




CHAPTER 2

Tank Blowdown Example

This chapter will give you the big picture of AFT xStream's layout and
structure. To accomplish this purpose, a model with two pipes and three
junctions will be built to capture the system effects when a valve is
opened.

A number of other example model discussions are included on the AFT
help site. It can be opened from the Help Menu by choosing "Show
Examples" and selecting "Metric Units....".

Topics covered

e Model building basics
e Entering pipe and junction data
e Entering transient data

e Graphing output results

Required knowledge

No prior knowledge is required for this example.
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Model file

The file listed below contains a completed version of this example and
can be located in the Examples folder as part of the AFT xStream
installation. This file can also be downloaded from the AFT xStream
help site from the Tank Blowdown Example page:

o Metric - Tank Blowdown.xtr

This example is also provided in US units under the US Units file name,
US - Tank Blowdown.xtr.

This example will require you to build the model from scratch to help
familiarize yourself with the steps required to build a complete model in
AFT xStream. Therefore, use this example model file as a reference
only.

Problem statement

This problem evaluates the initial design for a tank that undergoes a
blowdown. Nitrogen flows out of a supply tank into a 2 inch line as a
part of the blowdown. The flow is controlled by opening and closing a
valve in the 2 inch line.

This model will simulate opening a valve in 0.1 seconds. The valve will
remain open for the remainder of the simulation.

Graph the pressure and temperature of the tank to observe how both
parameters change with time. Also, graph the Mach number,
temperature, and velocity at the discharge of the second pipe to
understand how the flow properties change as the blowdown progresses.

Step 1. Start AFT xStream

> To start AFT xStream, click Start on the Windows taskbar and open

AFT xStream. (This refers to the standard menu items created by setup.
You may have chosen to specify a different menu item).

After AFT xStream starts, the Startup window, as shown in Figure 2.2,
appears. This window provides you with several options before you start
building a model:
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AFT xStream’

Activate Modules (license needed)

[ PFA (Pulsation Frequency Analysis) Unit System Check for Latest Release
O US Orly @ Both with US Defautts
(O Metric Only () Both with Metric Defaults

Filter
Select Working Fluid @® Al Units Subscribe to Receive Netifications
N () Comman Only
@ 1Will Select Fluid Later (O Common Plus Selected Industriss Help Files

O Use AFT Standard "Air ) .

O SelectA Recently Used Fluid Ducting Compressed Ar
Pipeline

OpenHelp File (US & Metric)

Open Example Help (US) (Metric)

File with Descriptions
" Show Sample Units ™"

Language ¥

2D or Isometric Work:

Modeling Preferences Video Tutorials

Pipe Matenal ¥
Units: All US and Metric units (Metric defoulis) P Show List of Available Online
Language: English Video Tutorials (internet)
Interface: 2-D workspace, grid notshown
Default Pipe Material: Mone
. Note: For complete preferences, select User Options from the Tools menu
Start Building Model
Remember My Preferences and Hide Discard and Hide

[ Dont Show This Startup Window Again

Figure 2.1 Startup window with Modeling Preferences expanded

Some of the actions available from the AFT xStream Startup window
are:

e Open a previous model, browse to a model, or browse to an
Example

e Activate an Add-on Module

e Select "AFT Standard "Air" " or a recently used fluid to be the
Working Fluid

e Review or modify Modeling Preferences

e Select a Unit System

e Filter units to include Common Only or Common Plus Selected
Industries
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e Choose a Grid Style
e Select a Default Pipe Material

e Access Resources, such as Quick Start Guides, Help Files, and
Video Tutorials

If this is the first time that you have started AFT xStream, Modeling
Preferences will be expanded in the middle section of the Startup
Window, as shown by Figure 2.1. If this is not the first time that you
have started AFT xStream, the Startup Window will appear with
Modeling Preferences Collapsed, as shown in Figure 2.2.

When collapsed, you can view your current Modeling Preferences at the
bottom of Start a New Model. To further review or adjust your
preferences, click the "Modify >>" button (Figure 2.2).

AFT xStream’ AT

OPEN A MODEL START A NEW MODEL RESOURCES

My Files Activate Modules (license needed)

[] PFA (Pulsation Frequency Analysis) Check for Latest Release

Subscribe to Receive Notifications

Select Working Fluid

® |'Will Select Fluid Later Help Files
O Use AFT Standard "Air"
O Select A Recently Used Fluid Open Help File (US & Metric)
Open Example Help (US) (Metric)
File with Descriptions
Other Files Modeling Preferences Video Tutorials

Show List of Available Online

Units: All US and Metric units (Metric defaults) Video Tut Is fint Y
ideo Tutorials (intemne

Language: English
Browse to a File... Interiace: 20 workspace, arid notshown
Default Pipe Material: Mone

Browse to Examples...

Start Building Model

] Dont Show This Startup Window Again

Figure 2.2  AFT xStream Startup window
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With Modeling Preference expanded, as in Figure 2.1, select "Both with
Metric Defaults" under Unit System. Select "Common Only" under
Filter to show only commonly used units, instead of "All Units."

You can "Show Sample Units" to see which units will be included based
on your selections, as shown in Figure 2.3.

MODELING PREFERENCES

Units 2

(- Pressure Units X
[+- Mass Flow Rate Units

; aults
=- \l'folumetric Flow Rate Unils

Defaults

e gal/min
- liter/hr

- liter/min
- m3/hr

7
Lud}

- Length Units
- Diameter Units
.. Nianerhe | Iniz

T
)

.
ual}

Hide Sample

‘ - wv Hide Sample Units vv
Units ‘

Language

2D or Isometric

Pipe Material

Mote: For complete preferences, select User Options from the Tools menu

Remember My Preferences and Hide Discard and Hide

Figure 2.3  "Show Sample Units" with "Common Only" selected

Click "Start Building Model".

The Workspace window is initially the active window, as seen in Figure
2.4.
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The Workspace window

The Workspace window is the primary interface for building your
model. This window has three main areas: the Toolbox, the Quick
Access Panel, and the Workspace itself. The Toolbox is the bundle of
tools on the far left. The Quick Access Panel is displayed on the far
right. It is possible to collapse the Quick Access Panel by clicking on
the thumbtack pin in the upper right of the Quick Access Panel in order

to allow for greater Workspace area. The Workspace takes up the rest of
the window.

= AFTxStream - Untitled (Workspace)

- [m] X
File Edit View Analysis Tools Library Amange Window Help
ER& B IO08 & 3 Search: £ A 4t 8 | B AnalysisSetup.. i3 Run Model I
/" Workspace ’_aMch\ Data | [ Output | %21 Graph Results | ® Visual Report ‘ I *
P I @ - 2. a (S

=]
o @ Primary Window
> o Tabs Quick Access Panel —
=9
& Float Toolbar Quick Access Panel Pin
i 5 Scenario Manager in ~
2o Work e Quick Access Panel
orkspace
[ma =] .
~ Model Status light
[au]
Status Bar
b
o Workspace
Workspace Overview Map
Zoom Tools
3 v wg Scenario | S| Properties
Base Scenaric B Qe © { } @ —+~o0 | @0 || 3 oveniewMap (=] Add-on Medules | @

Figure 24  The Workspace window is where the model is built.
The Status Bar shows the model status.

You will build your pipe flow model on the Workspace using the
Toolbox tools. The Pipe Drawing tool, on the upper left, is used to draw
new pipes on the Workspace. The Annotation tool allows you to create
annotations and auxiliary graphics.

Below the two drawing tools are icons that represent the different types
of junctions available in AFT xStream. Junctions are components that
connect pipes and also influence the pressure or flow behavior of the
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pipe system. The junction icons can be dragged from the Toolbox and
dropped onto the Workspace.

When you pass your mouse pointer over any of the Toolbox tools, a
tooltip identifies the junction's function.

Unpinning the Quick Access Panel

By default, the Quick Access Panel is pinned to the Workspace window
so that it is constantly displayed. The Quick Access Panel can be
unpinned so it is only displayed when the mouse is hovered over the tab
displayed on the right edge of the Workspace window. You can unpin
the Quick Access Panel by clicking on the pin icon displayed in the top
right corner of the Quick Access Panel (Figure 2.4).

Step 2. Lay out the model

To lay out the tank blowdown model, you will place a Tank junction, a
Valve junction, and an Assigned Pressure junction on the Workspace.
Then you will connect the junctions with pipes.

A. Place the Tank junction

> To start, click and drag a Tank junction from the Toolbox and drop
it on the Workspace. Figure 2.5a shows the Workspace with one Tank.

Objects and ID numbers

Items placed on the Workspace are called objects. All objects are
derived directly or indirectly from the Toolbox. AFT xStream uses three
types of objects: pipes, junctions and annotations.

All pipe and junction objects on the Workspace have an associated 1D
number. For junctions, this number is, by default, placed directly above
the junction and prefixed with the letter "J". Pipe ID numbers are
prefixed with the letter "P". You can optionally choose to display either
or both the ID number and the name of a pipe or junction. You also can
drag the ID number/name text to a different location to improve
visibility.

The Tank you have created on the Workspace will take on the default
ID number of one. You can change this to any desired number greater
than zero, but less than 100,000.
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Editing on the Workspace

Once on the Workspace, junctions can be moved to new locations and
edited using the features on the Edit menu. Cutting, copying, and pasting
are all supported. Undo is available for most formatting and arrangement
actions on the Workspace.

Workspace o x

Pl -~ @ (hre-&= B S  Fa- "B v

= 5
© 0
o @
=5
o
sl
b=
oo
T
e

Base Scenario @ Q 100% | (=

(1
(*
1
=)
O

Figure 2.5a Tank junction placed

B. Place the other junctions

Drag a Valve and an Assigned Pressure junction from the Toolbox and
drop them on the Workspace so that your model appears similar to
Figure 2.5b.

If the icons do not line up exactly, the calculations will not be affected.
You can align the icons by using the Align feature selected from the
Arrange menu.

Note: The relative location of objects in AFT xStream is not important.
Distances and heights are defined through Property window dialog
boxes. The relative locations on the Workspace establish the
connectivity of the objects but have no bearing on the actual length or
elevation relationships.
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‘Workspace o x

P - @ KMe -8 = B 03I 2 v

=

- =

o @
o @
=1
™ ™ 0 B Y3
il 5
Yo
(- v
s A

»@Lq:b

Base Scenario [ Q100% © { ] & +o0| @2

Figure 2.5b All junctions placed

Before continuing, save the work you have done so far with "Save
As" from the File menu. Choose "Save As" from the File menu and
enter a file name (Tank Blowdown, perhaps) and AFT xStream will
append the ".xtr" extension to the file name.

C. Draw a pipe between J1 and J2

Now that you have all of the junctions, you need to connect them with
pipes.

To create a pipe, click the Pipe Drawing Tool icon on the Toolbox.
The pointer will change to a crosshair when you move it over the

Workspace. Draw a pipe above the junctions by clicking and dragging
the mouse, similar to that shown in Figure 2.5c.

The pipe object on the Workspace has an ID number (P1) that is shown
near the center of the pipe.
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‘Workspace

Pl -~ % < @ (kTe-Al=wa

Toolbax

- =

o @
o @
=5
ar M 0 b Y3
il 5

ED Pl
O3 \
s A

»@Lq:b

Base Scenario | [ Qe @ ) H o+1 O3

Figure 2.5¢c First pipe drawn

To place the pipe between J1 and J2, use the mouse to grab the pipe
in the center and drag it so that the left endpoint falls within the J1 Tank
icon, then drop it there (see Figure 2.5d). Next, grab the right endpoint

of the pipe and stretch the pipe, dragging it until the endpoint terminates
within the J2 Valve icon (see Figure 2.5¢).
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‘Workspace
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Figure 2.5d First pipe partially connected
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Figure 2.5e First pipe fully connected

D. Add the remaining pipe

A faster way to add a pipe is to draw it directly between the desired
junctions.

Activate the Pipe Drawing Tool again. Position the cursor on the J2
Valve, then press and hold the left mouse button. Stretch the pipe across
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to the J3 Assigned Pressure junction, then release the mouse button. All
objects in the model should now be graphically connected as they are in
Figure 2.5f.

Save the model by selecting "Save" in the File menu, by clicking the
"Save" icon on the Toolbar, or by entering Ctrl+S.

‘Workspace o x

L ALaRdie i, @- kT -s = wa B O =R

= =

c @

o @

=5

[] P1 F2

s O ¢

o

O3

B

o v

<

Figure 2.5f All pipes and junctions placed

Reference positive flow direction

There is an arrow on each pipe that indicates the reference positive flow
direction for the pipe. AFT xStream assigns a flow direction
corresponding to the direction in which the pipe is drawn.

You can reverse the reference positive flow direction by choosing
"Reverse Direction" from the Arrange menu or selecting the Reverse
Pipe Direction button on the Workspace Toolbar.

The reference positive flow direction is used for reference purposes only
and need not be the actual flow direction. If the reference positive flow
direction is the opposite of that obtained by the solver, the output will
show the flow rate as a negative number. However, when used with
compressors and certain other junction types the pipes must be in the
appropriate forward flow direction because that is how AFT xStream
determines which side is suction and which is discharge.
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Note: Some users find it desirable to lock objects to the Workspace
once they have been placed. This prevents accidental movement and
disruption of the connections. Locking also helps prevent accidental
deletion of your output once a solution has been reached. You can lock
all the objects by choosing "Select All" from the Edit menu, then
selecting "Lock Object" from the Arrange menu. The Lock Object
button on the Workspace Toolbar will appear depressed indicating it is
in an enabled state, and will remain so as long as any selected object is
locked.

Step 3. Define the model components

The model must have all pipes and junctions defined in order for it to
run. This step encompasses the proper input data and connectivity for all
pipes and junctions.

Object status

Each pipe and junction has an object status. The object status tells you
whether the object is defined according to AFT xStream's requirements.
To see the status of the objects in your model, click the light bulb icon
on the Workspace Toolbar (alternatively, you could choose "Show
Object Status" from the View menu). Each time you click the light bulb,
"Show Object Status" is toggled on or off.

When "Show Object Status" is on, the ID numbers for all undefined
pipes and junctions are displayed in red on the Workspace. Objects that
are completely defined have their ID numbers displayed in black. (These
colors are configurable through User Options from the Tools menu.)

Because you have not yet defined the pipes and junctions in this model,
all the objects' ID numbers will change to red when you turn on "Show
Object Status."

Showing undefined objects

Another useful feature is the List Undefined Objects window (Figure
2.6). This can be opened from the View menu by clicking on "List
Undefined Objects", or by clicking the List Undefined Objects icon on
the Workspace toolbar. All objects with incomplete information are
listed. Click on an undefined pipe or junction to display the property
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data that is missing. Click the close button on the bottom right to stop
showing this window.

=~ Undehned Fipes -3
2 Fipe

I Undefined Junchions

1 Tank
2 Walve
3 Assigned Pressure

»

&= Undefined Properties for Pipe 1:

Fipe Length
Fipe Inner Diameter
Roughness./Friction

ol

H saverl. Chcopvan B 5 ®

Figure 2.6 = The List Undefined Objects window lets you see the
undefined properties for each undefined object

A. Enter data for the Tank

As shown in Figure 2.5f, the J1 junction is a Tank junction.

>  To define the first tank, open the J1 Tank Properties window (Figure
2.7) by double-clicking on the J1 junction

Note: You can also open an object's Properties window by selecting the
object (clicking on it) and then either pressing the Enter key or clicking
the Open Pipe/Junction Window icon on the Workspace Toolbar.
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> Enter the following properties into the J1 Tank Properties window:
1. Enter 0 meters for Elevation

Set the Tank Model to "Finite"

Set 45 bar for Pressure

Set the Temperature to 150 deg. C

Set the Volume to 8.5 meters3

Set the Initial Conditions to "Known"

A o

Set the Thermodynamic Process to "Adiabatic"

Note: You can specify default units for many parameters (such as
meters for length) in the User Options window, accessed from the Tools
menu under Preferred Units.

The highlight feature displays all the required information in the
Properties window in light blue. The highlight feature is on by default.
You can toggle the highlight off and on by double-clicking the top part
of the window or by pressing the F2 key. The highlight feature can also
be turned on or off in the User Options window, or accessed from the
View menu by selecting the "Highlight in Pipe and Jct Windows"
option.

By default, the junction's name is the junction type. The name can be
updated by entering it in the Name field at the top of the window. In
Figure 2.7, the name of Tank J1 is "Supply Tank." The name can be

displayed on the Workspace, Visual Report, or in the Output.

Most junction types can be entered into a custom Junction Library
allowing the junction to be used multiple times or shared between users.
To select a junction from the custom library, choose the desired junction
from the Library List in the junction's Properties window. The current
junction will get the properties from the library component.
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Tank Properties

Number: |:|

Name: |5|_|pp|y Tank w |

0K

Cancel

Library Jet: | Bevation

Copy Data From Jct . w I:I meters >

Jump...

=l IER

Help

J Tank Model | Optional | Design Alerts | Notes | Status |

Tank Model
() Infinite
(@ Finte

Intial Conditions

Pressure: bar v
(@ Temperature:

150 e
O Enthalpr'_.': _ deQ' c
Finite Tank Parameters

Fixed Volume: meters3 ~

Initial Conditions

® Known

() Calculate From Steady State
Themodynamic Process

®) Adiabatic

() Isothermal

() Known Heat and Volume vs. Time

Figure 2.7  Properties window for Tank J1

The "Copy Data From Jct..." list will show all the junctions of the same
type in the model. This will copy desired parameters from an existing
junction in the model to the current junction.

Using the tabs in the Properties windows

The information in the Properties windows is grouped into several
categories and placed on separate tabs. Click the tab to bring its
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information forward. Figure 2.7 is an example of a Tank's Properties
window.

The Tank Model tab is the tab that appears first when the Tank junction
is opened and contains all of the inputs required to define the Tank in
steady-state. While the Tank Model tab is specific to the Tank junction,
the first tab opened for any junction will contain all inputs required for
that junction to be defined.

The Optional tab allows you to enter different types of optional data.
You can select whether the junction number, name, or both are
displayed on the Workspace. Some junction types also allow you to
provide a guess for initial pressure as well as other junction specific
data.

Each junction has a tab for notes, allowing you to enter text describing
the junction or documenting any assumptions.

The Status tab will state whether all required input data is present for a
given junction. If not, it will list all inputs that are incomplete.

Click OK. If "Show Object Status" is turned on, you should see the J1
ID number turn black again, telling you that J1 is now completely
defined.

The Inspection feature

You can check the input parameters for J1 quickly, in read-only fashion,
by using the Inspection feature. Position the cursor on the Tank J1
junction and hold down the right mouse button. An information box
appears, as shown in Figure 2.8.

Inspecting is a faster way of examining the input (and output, if output
results are available) than opening the Properties window.
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Figure 2.8 Inspect junction properties from the Workspace by
clicking and holding the right mouse button

B. Enter Valve data

The J2 Junction is a Valve junction. This junction will be the initiator of
the transient.

> Double-click the J2 junction icon to open the Valve Properties window
(Figure 2.9).

1. Verify the Elevation is 0 meters

Note: This value by default will be equal to the last elevation used.

2. Choose the loss model as Kv and enter a Kv value of 52. This
typically represents the valve's Kv during steady-state.

3. Enter an Xt of 0.7

4. Click the Optional tab and click the radio button labeled "Closed"

under Special Condition. This will set the steady state Kv equal to
0.
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Valve Properties

Number:
Name:

Librany Jet:

Copy Data From Jet...

7 Upstream Pipe: 1 « 0K
Valve - Downstream Pipe: 2 m _—
Elevation
GRS 3 .
@ Help

J Loss Model ‘ Transient | Optional | Design Alerts | Motes | Status |

® Kv

Subsonic Loss Model
(O Cv (ANSI/ISA)

Kv: |52

% (07

Open Percentage Data

Loss Source
= (®) Fixed Kv
(O) From Open Percent Table
{on Optional Tab)
Guide for At... B

Open Pct.

Kir Flowhrea | Xt |~ Edit Table  ~

:
| 2|
| 3
| 4
| 5

Flow Area Units:

[ Exit Valve {optional)

meters2 ~ Open Pct Increment: Autofill

Show Graph...

Create Kv/Open...

] Optional Data

Figure 2.9  Input data for Valve junction J2

5. Click the Transient tab and select "Time" under "Initiation of
Transient" to indicate that the valve closure will be initiated at the
time you specify, then enter the following Kv vs. Time data (Figure

2.10).
Time (seconds) Kv Xt
0 0 0.7
0.1 52 0.7
240 52 0.7

The first data point of the table must match the steady-state value
of the junction. In this case, the valve is closed in the initial steady-
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state due to the Special Condition specified in Step 4. Therefore,
the initial transient data point automatically populates the valve as
being closed (Kv of zero means the valve is closed). The valve then
fully opens over a period of 0.1 seconds. It remains in this position

for the rest of the simulation.

Valve Properties

Number: 2 Upstream Fipe: 1 o 0K
Name- Valve Downstream Pipe: 2 _—
Fremis Elevation
rary Jet:
CR = 3 .
Copy Data From Jet... ~ =
P Help
Loss Model | [ Transient | o Optional | DesignAlerts | Notes | Status |
Transient Special Condition Transient Data *# Source
(® None (® Absolute Values ® User
() lgnore Transient Data () Relative To Steady-State Value (O) Open % Table
Initigtion of Transient O e Fill %t from table
® Time O Dual Event Cycic Dala | Time | | |A
(O Single Evert () Dual Event Sequential Point ) K
1 0 0 07
2 0.1 52 07
3 240 b2 07
4
5
6
7
8
9
0
11
12
13 >
Edit Table = | Show Graph...
[] Repeat Transient
m Transient

Figure 2.10 Transient input data for Valve junction J2

Click the OK button. There should now be a "T" symbol next to
the Valve junction in the Workspace, indicating that transient data
is entered for the junction. The Valve junction in the Workspace
will additionally have a red "X" next to it indicating that the
junction contains a special condition.
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C. Enter Assigned Pressure data
The J3 Junction is an Assigned Pressure junction.

Double-click the J3 junction icon to open the Assigned Pressure
Properties window (Figure 2.11).

1. Verify the Elevation is 0 meters

2. Verify the Stagnation radio button is selected for "Boundary
Specification"

Enter a Stagnation Pressure of 1 bar

4.  Verify the Temperature radio button is selected and enter a value of
21.1 deg. C

5. Click the OK button. The Assigned Pressure junction should be
fully defined.
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Assigned Pressure Properties

Name: |ﬁssigned Pressure v| Cancel
Elewvation
Library Jet: bt i Jump..
Copy Data From Jet... ~ D biE i =
P Hep

J Pressure Model | Loss Coefficient I Transient I Optional | Design Alerts I Notes | Status |

Boundary Specification
(®) Stagnation () Static
Stagnation Pressure: bar ~
(® Temperature
Stagnation deg. C w
() Enthalpy

Figure 2.11 Input data for Assigned Pressure junction J3

D. Enter pipe data for P1

Data for pipes and junctions can be entered in any order. In this
example, the junctions were done first. The next step is to define all the
pipes. Double-click the pipe object on the Workspace.

> First, open the Pipe Properties window for Pipe P1. The Pipe Model
tab opens by default (Figure 2.12).
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1. In the Pipe Material field, choose "Steel - ANSI"
2. In the Size field, select "2 inch"
3. In the Type field, select "STD (schedule 40)"
4. Specify the Length as 6.1 meters
5. For the Friction Model field, verify "Standard" is selected
Pipe Properties
Mumber: Upstream Junction: 1 Q/ QK
Name: |Pipe Downstream Junction 2 m Cancel
Copy Data From Pipe... ~ | | Copy Previous 1 Jump...
D Hep
Fipe Mode| | Fittings & Losses | Heat Transfer | DesianAleris | Optional | Notes | Status |
Size Length
Pipe Material: | Steel - ANSI i meters ~
Size: 2inch b
Type: STD (scheduls 40) >
Inner Diameter: 5250179 cm ~
[ 1D Reduction {Scaling):
Friction Model
Dg; je{ P Absolute Roughness ~ Load Defautt
ser Specifi
® | Standard en e

Figure 2.12 Properties window for Pipe P1

The Pipe Properties window

The Pipe Properties window offers control over all important flow
system parameters that are related to pipes.

The Inspect feature can be accessed not only from pipes and junctions
located on the Workspace, but also from within the Properties window
of each pipe (and certain junctions). This is helpful when you want to
quickly check the properties of objects that connect to a pipe or junction
whose Properties window you already have open.
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To inspect a junction connected to a given pipe, position the mouse
cursor on the connected junction's ID number in that pipe's Properties
window (located at the top right of the Pipe Properties window) and
hold down the right mouse button. This process can be repeated for any
junctions that state the upstream and downstream pipe in the junction's
Properties window by holding the right mouse button on the pipe's ID
number.

By double-clicking the connected junction number, you can jump
directly to the junction's Properties window, or you can click the Jump
button to jump to any other part of your model.

Click OK to finish defining P1.

E. Enter pipe data for P2
Similar to Pipe P1, enter the following data for pipe P2:
In the Pipe Material field, select "Steel - ANSI"

In the Size field, verify "2 inch" is selected
In the Type field, verify "STD (schedule 40)" is selected
Specify the Length as 457 meters

For the Friction Model field, verify "Standard" is selected

AR e

Click OK to finish defining P2

> Check if all the pipes and junctions are defined by clicking on the
List Undefined Objects button. If all data is entered, no items should
appear in the Undefined Objects window. If items are present, open the
corresponding Properties windows for the incomplete items from the
workspace. The Status tab on each Properties window will indicate what
information is missing.

F. Review model data
> Save the model. It is also a good idea to review the input using the

Model Data window.

Reviewing input in the Model Data window

The Model Data window is shown in Figure 2.13. To change to this
window, you can select it from the Window menu, you can click on the
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Model Data tab, or you can press Ctrl+M. The Model Data window
gives you a text based perspective of your model. Selections can be
copied to the clipboard and transferred into other Windows programs,
exported into Excel, saved to a formatted file, printed to an Adobe™
PDF, or printed out for review.

Data is displayed in three general areas. The top is called the General
data section, the middle is the Pipe data section and the bottom is the
Junction data section. Each section is collapsible using the button at the
top left of the section. Further, each section can be resized.

The Model Data window allows access to all Properties windows by
double-clicking on any input parameter column in the row of the pipe or
junction you want to access.

Medel Data
@ e & hBE

# | General |Notes

General Segments Per Pipe= 10
Mach Number Increment=0.01

d ata Pressure Tolerance= 0.0001 relative change

. Mass Flow Rate Tolerance= 0.0001 relative change

section Enthalpy Tolerance= 0.0001 relative change
Concentration Tolerance= 0.0001 relative change
Flow Relaxation= {Automatic)
Pressure Relaxation= (Automatic)

s

# | Pipes | Pipe Fittings & Losses ~ Pipe Detail Summary

nits | Diameter | Diam. Units | Dats Set nits {Up.Down)
section Pipe  Yes 6.1 meters 5250173 cm Standard  0.004572 cm 0 1.2 Cyli
Pipe Yes 457 meters 5250179 cm Standard 0.004572 cm ] 2.3 Cyh

P- d t Pipe | Name | Fipe Length | Length | Hydraulic | Hydraulic | Friction | Roughness | Roughness | Losses (K) | Initial Flow | Initial Flow | Junctions G
Ipe da a—\ Defined Uni i Units Uni

1 -

2

< >

# | Assigned Pressure | Tank | Valve | Transient Data

Junction Assigned Pressure Name Object | Flevation | Elevation | Library | Pressure | Pressure | Pressure | Temperature/Enthalpy | Tempe
d t Defined Units Source Units Type
ata
Section 3 Assigned Pressure ez 0 meters 1 bar Stagnation 21.1 deg. C
< >
Base Scenaric Q, 1W00% =) 1) (+)

Figure 2.13 The Model Data window displays all input in text form

Step 4. Specify Analysis Setup

> Next, click Analysis Setup on the Main Toolbar to open the Analysis
Setup window (see Figure 2.14). The Analysis Setup window contains
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six or more groups depending on which modules you may be using.
Each group has one or more items. A fully defined group has every item
within it defined with all required inputs. Complete every group to run
the Solver. A group or item that needs more information will have a red
exclamation point to the left of the group or item name. After
completing a group, the group icon shows a green circle with a
checkmark. After defining all groups, thus completing the Analysis
Setup, the Model Status light in the lower right corner of the Workspace
turns from red to green.

The Analysis Setup window can also be opened by clicking on the
Model Status Light on the Status Bar at the bottom right corner of the
AFT xStream window (Figure 2.4).

Analysis Setup
[F®  Modules
/a | Fluid Properties
| Fluid
&1 Pipes and Junclions

| Pipes and Junctions

! Pipe Sectioning and Output
&  Transient Conirol
V Simulation Mode/Duration

© Transient Solver Initializati

@b  Pipe Sectioning and Output ~ Argon

s RAuid

Fluids Awailable in Library
(®) AFT Standard () ASME Steam Tables () Chempak () NIST REFPROP

~ Name &

Air
Ammonia

Benzene
Butane
Carbon Dioxide v

v Add to Model v

Fluids in Cument Model

Forces

L%
0 Lo
o
=]

Environmenial Properties

Miscellaneous

Collapse All Groups

Specific Heat Ratio Source

Equation of State: ~ = l:l @® lbray (O User
Enthalpy Model: ~

Edit Fluid List...

2 Same As Parent P Hep o 0K Cancel

Figure 2.14 The Analysis Setup window tracks the defined and
undefined model input

A. Specify the Modules group

Under the Modules group, click on the Modules item to open the
Modules panel, shown in Figure 2.14. Here you can enable and disable
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the Pulsation Frequency Analysis add-on module. By default, the model
will have all modules disabled. Therefore, make no changes to this panel
for this example.

B. Specify the Fluid Properties group

> Select the Fluid item to open the Fluid panel (Figure 2.15).
This panel allows you to specify the fluid used in the model.
You can select a fluid from the standard AFT xStream fluid library
(AFT Standard), or select ASME Steam Tables. Additionally, you can
select multiple fluids and/or create mixtures using the included NIST
REFPROP library or optional add-on Chempak library. Users can also
add their own custom fluids to the AFT Standard library.
> Select the AFT Standard fluid option, then choose "Nitrogen (GN2)"
from the list and click the "Add to Model" button.
Analysis Setup x
[7®  Modules | Aud
gkl Flids Available in Library
:M Fluid Properties ~ (@ AFT Standard () ASME Steam Tables () Chempak () NIST REFPROP
© “Fluid Name o
©1 PipesandJuncions  ~ it
! Pipes and Junctions Propane
Propylene
4|  Pipe Sectioning and Output ~ Refrigerant C-318
| Pipe Sectioning and Output Steam v
#1  Transient Control . v Addto Model v
| Simulation Mode/Duration FIEo T )
Mitrogen (GN2)
Transient Solver Initialization
540 Forces ~ Remove Fuid
AFT Amow ™ Steady o
5O Soluton ‘Add to Library.
#9  Environmental Properfies =
E® Miscellaneous ~ Specific Heat Ratio Source
Equation of State: | Redich-Kwong ~ z ® lbray (O User
Enthalpy Model:  |Generalzed .~ e [ ]
Edit Fluid List...
[ SameAsPaent - (P Help of OK E3 cancel

Figure 2.15 The Fluid panel is where you specify the fluid
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C. Inspect the Pipes and Junctions group

The Pipes and Junctions group in the Analysis Setup window contains
the Pipes and Junctions panel, which is used to show the status of the
pipes and junctions on the workspace. This item is incomplete if there
are any undefined pipes/junctions on the Workspace, or if there are no
pipes/junctions on the Workspace. In this example the objects in the
Workspace are fully defined, so this item is marked as complete.

Running models in steady-state

After fully specifying the pipes and junctions, sufficient information
exists to run the model in steady-state. You can run the model in steady-
state by selecting the Simulation Mode/Duration panel from the
Transient Control group and then choosing "AFT Arrow™ Steady" for
the Time Simulation. If you do this, the other inputs on the Simulation
Mode/Duration panel and the Pipe Sectioning and Output panel will no
longer be required, and the model can be run.

In general, it is a good idea to always run your model in steady-state
before running the full transient analysis to make sure the model is
giving reasonable results. However, in this case the model has no flow
in the steady state, and a steady state run is trivial.

D. Specify the Pipe Sectioning and Output group

The next panel is the Pipe Sectioning and Output panel in the
corresponding group. The Pipe Sectioning and Output panel divides
pipes into computation sections in a manner which is consistent with the
Method of Characteristics (MOC).

To satisfy the MOC, the following equation must be satisfied:

where At is the time step, Ax is the section length, and c¢ is the sonic
velocity.

> Enter "1" for the Minimum Number of Sections Per Pipe

The Minimum Number of Sections Per Pipe determines the section
length by taking the quotient of the shortest pipe's length and the
Minimum Number of Sections. Increasing the number of sections in a
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model will always have a positive correlation to the model accuracy as
the error inherent to the Method of Characteristics decreases when the
step size is made smaller. However, the run time of the model increases
quadratically as well, since each added section to the shortest pipe
increases the number of calculations for each time step. This increase in
run time is exacerbated when there is a large disparity between the
minimum pipe length and the length of the longest pipe, such as exists
in this model. The Minimum Number of Sections Per Pipe for this
example will be set to 1 for expediency, but note that it would be wise
to use more computational sections if you are running an AFT xStream
model for real projects.

Define the Estimated Maximum Pipe Temperature During
Transient as 930 deg. C.

The Estimated Maximum Pipe Temperature During Transient is used to
calculate the maximum sonic velocity. Since all pipes in the network
must be solved together, the time step must be the same for each pipe.
However, the sonic velocity will not be equivalent for all of the pipes.
Therefore, the sonic velocity at the specified maximum temperature is
used to find a uniform time step for the system. Without a uniform time
step, the MOC could fail. Choosing a maximum temperature that is
much higher or much lower than the maximum temperature calculated
during the run can result in additional uncertainty in the MOC solution.
It is generally recommended to choose a conservatively high
temperature for the model initially. The results of the initial run can then
be used to refine the Estimated Maximum Temperature During
Transient for subsequent runs.

The Sectioning Summary underneath the inputs will be partially filled
in. Certain properties, such as total steps and total pipe computations,
need the Simulation Mode/Duration panel completed to be defined.
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Figure 2.16 The Sectioning panel in the Analysis Setup window is
used to calculate the time step of the model
E. Specify the Transient Control group
The Transient Control group has two items, the Simulation
Mode/Duration panel and the Transient Solver Initialization panel. The
Simulation Mode/Duration panel allows you to choose the simulation
type, and to specify the time that the simulation starts and stops.
The Transient Solver Initialization panel contains advanced settings
related to the resolving artificial transients in the model, and typically
should not be changed.
> Select the Simulation Mode/Duration panel (Figure 2.17). Enter 0
seconds for Start Time and 240 for Stop Time.
>

Click OK to accept the current settings. The last Analysis Setup panel
should be completed. The model is ready to be solved.
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Figure 2.17 The Simulation Mode/Duration panel is used to

specify the simulation type and the time span for the
transient

»  Save the model.

Step 5. Run the solver

»  Choose "Run Model..."from the Analysis menu or click the "Run
Model" button on the Main Toolbar. During execution, the Solution
Progress window displays the state of the simulation (Figure 2.18). You
can use this window to pause or cancel the solver's activity.

Note the run time may take 5-10 minutes for this model, depending on
your computer's speed.
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Figure 2.18 The Solution Progress window displays the state of
the simulation

The two solvers

AFT xStream has two solvers. The first is called the AFT Arrow™
Steady Solver, which as its name suggests, obtains a steady-state
solution to the pipe network. The second solver is called the Transient
Solver and solves the gas transient equations.

The AFT Arrow™ Steady solver and Transient solver use different
sectioning methods, which causes small discrepancies between the
converged AFT Arrow™ Steady solution and the first time step of the
transient solution. To allow artificial waves caused by these
discrepancies to die out, AFT xStream runs the Transient solver for a
period of time before the transient simulation begins. Once the artificial
transients have died out AFT xStream checks the solution with resolved
artificial transients against the AFT Arrow™ Steady solution. If the
mismatch between the beginning and end of the artificial transient
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resolution process is sufficiently small AFT xStream proceeds with the
transient simulation. See the chart in Figure 2.19 as a visual
representation of the process described above.

‘ Transient Solver Initialization ole Transient Simulation "

L TR B O S M Ism atCh I I//’-'

) Resolving
AFT Arrow Avrtificial Transients

>

Arrow Resolved
Converged Solution

Figure 2.19 Illlustration of the Transient Solver Initialization
process with artificial transient resolution

When the solution is obtained, click the Output button to display the
text-based Output window. The information in the Output window can
be reviewed visually on the screen, saved to a file, exported to a
spreadsheet-ready format, copied to the clipboard, or printed.

The transient output file

When the Transient Solver runs, the transient output data is written to a
file. This file is given the same name as the model itself with a number
appended to the name, and with an ".out" extension appended to the end.
For all transient data processing, graphing, etc., the data is extracted
from this file. The number is appended because AFT xStream allows the
user to build different scenarios all within this model. Each scenario will
have its own output file; therefore, the files need to be distinguishable
from each other.

The output file will remain on disk until the user erases it or the model
input is modified. This means that if you were to close your model right
now and then reopen it, you could proceed directly to the output window
for data review without re-running your model.
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Step 6. Review the Output window

Click Output after the solver is finished. The Output window (Figure
2.20) is similar in structure to the Model Data window. Three areas are
shown, and you can minimize or enlarge each section by clicking the
arrow next to the General, Pipes, and All Junctions tabs. The items
displayed in the tabs can be customized with the Output Control window
from the Tools drop-down menu.

The General section will open by default to the Warnings tab if any
Warnings or Cautions were encountered during the simulation. This
model should generate a Caution that the Maximum Transient Pipe
Mach Number is at least 0.2 higher than the steady pipe Mach number,
which occurs since there is no flow in the system at steady state. When
this Caution is present, the effect of pipe sectioning on results can be
significant. The impact of pipe sectioning will be addressed in greater
detail later in Step 10.

The Output window allows you to review both the steady-state and
transient results. The Pipes tab, All Junctions tab, and any specific
junction tabs in the Junction section (such as Branch, Tank, Valve, etc.)
show the steady-state results. A summary of the maximum and
minimum transient results for each pipe is given on the Transient
Max/Min tab in the Pipe section and is the active tab displayed in Figure
2.20.
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Output o x
Output
[l = T R
Control
#  General | Warnings | DesignAlerts = Applied Event By Jct | Event By Time | Valve Summary | Tank Summary
Messages
For an explanation of Wamings, click an item in this list and press F1 or search for Wamings' in the Help system.
General =\
~ CAUTION
SECtlon » The maximum transient pipe Mach number is atleast 0.2 higher than the steady pipe Mach number atthe same location.
If sectioning was determined from the Resclved Solution, theaccuracy of the transient simulation may not be sufficient for the higher flow pericds.
#  Pipes Axial Points | Transient Qutput | Transient Max/Min | Heat Transfer
Plpe Max. Static Max. Static Max. Static | Min. Static Min. Static Min. Static | Max. Mass Max. Mass Max. Mass | Min. Mass
R Pipe | Pressure Pressure Pressure Pressure Pressure Pressure Flowrate Flowrate Flowrate Flowrate
section (bar) Time (seconds) Station (bar) Time (seconds) Station (kg/sec) | Time (seconds) Station (kg/sec)
1 4500 0.0000 o 6.2620 2400 1 7793 0.1108 0| 0.000EA
2 40.58 2573 ] 0.5277 1283 75 77719 01017 0] -1.618E-
< >
2 | Al iPressure | Tank | Valve
. Jet Name Mass Flow Rate | dP Stag. | P Stag. | P Stag. | P Static | P Static dT TStag. | TSteg. | TStatic | T
Junction (AFT Arrow Thru Jet Total In Out In Out Stag. Inlet Outlet In |
section Steady) [kg/sec) (bar) (bar) (bar) (bar) (bar) | (deg.C) | (deg. C) | (deg.C) | (deg. C) | (dv
1 Supply Tank o 000 45000 45000 45000  45.000 00 15000 15000 15000
X2 Walve o 4400 45000 1.000 45000 1.000 1285  150.00 2110 150.00
3 Assigned Pressure o 0.00 1.000 1.000 1.000 1.000 0.0 2110 2110 2110
< >
Base Scenario | Q 100% & —L)—‘— )

Figure 2.20 The Output window displays steady and transient

output in text form

# | Pipes | fwialPoints | T Output | Ti Heat Transfer
PFipe Name | Mass Flow Wel. el. Mach | Mach | dP Stag. | P Stag. | P Stag. | P Static | P Static dT T Stag.
(AFT Arrow Rate In Out #in | #0ut Total In Qut In Qut Stag. Inlet
Steady) (kolsec) | (metersisec) | (meters/sec) tbar) | (ba) | (ban) | (ba) | (ban) | (deg O) | (deg O)
1 Fipe 0 0 0 0 0 0 45000 45000 45000 45000 0 150.00
2 Fipe o o o o o o 1.000 1.000 1.000 1.000 o 2110
£ >
Figure 2.21 The Output window displays the values of steady-

state parameters in the pipes tab

You can also review the solutions for each time step (i.c., a time history)
for which data was written to file on the Transient Output tab in the Pipe
section (Figure 2.22). Moving the slider along the bottom will change
the time step shown in the table.
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Time Step

&  General Wamings Designllerts Applied Standards | Event Messages By Jct | Event Messages By Time  Valve Summary = Tank Summary

A  Pipes Axial Points | Transient Output | TransientMax/Min | Heat Transfer

Step: 0 Static Mass Velocity Static
Time: 0.00000E+00 | Pressure | Flowrate Temperature
Pipe - Station (bar) | (kgisec) | (metersisec) | (deg. C)
0 45,000 0 0 150.00
1.000 0 0 21.10

Figure 2.22 The Output window displays transient data for each
time step in the Transient Output tab

The Event Messages By Time tab in the General section (Figure

2.23) allows you to review changes of states at junctions, such as the
onset of choking or the initiation of transient events. This is important in
gas transients as sonic choking changes the computational method used
by the solver. Therefore, knowing where choked flow occurs can
provide important insights about how the final results were tabulated.

*** Events Sorted By Jot Number ***

Walve Junction 2 became sonically choked at Time: 0.004421358 seconds

Valve Junction 2 lost sonic choking at Time: 0.05747765 seconds

Assigned Pressure Junction 3 became sonically choked at Time: 2.334477 seconds
Assigned Pressure Junction 3 lost sonic choking at Time: 128.887 seconds

Figure 2.23 The Output window displays event messages about
system behavior in the Event Messages by Time tab

The Output Control window can be accessed from either the Tools menu
or from the Output window Toolbar (Figure 2.24). The Output Control
window allows you to select the specific output parameters you want to
display in the Output window. You also can choose the units. If you do
not change any of the Output Control settings, the default Output
Control parameters are assigned.
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Output Control
Select thE\ Display Parameters | General | Eormat & fAction | Show Fipesilets |
A
output © Ppes T Junctions | F CompressorsFan | 4 Valves | 4 Heat Exchangers | [k Tanks | (i Cost Report | &5 Heat Transfer |
type @ Pipe Transient ]
[<Fiter | ‘Show Output in This Order ‘A
W Avaiable Outpus Faramelers Parameter p— [Units ~ A
Area Flow - e of Pipe v
Search Conpressibiity Factor Average Mass Flow Rate kglses <
: Compressibiity Factor lnict )
available Compressibity Factor Outlet Velocity Inlet metersiser |
Conductivity Average Velocity Qutlet metersisec -
parameters Conduclivity Inlet Mach Nomber I
Conductivity Qutlet ach Number Inlet T ———
Cenwection Coef 3 Mach Number Outlst
Convec temal
onve }M ot Ov:”éﬁ Add Pressure Loss Stag. Total bar -
LeDensty Stagnation Average Pressure Stagnation Inlet bar -
Density Stagnation Ilet
Th B o Ot Pressure Stagnation Outlet bar v
ese are Densiy Static Average Pressure Static Iniet bar -
parameters Density Static Inlet v Pressure Static Outlet bar =
that can be < id Temperature Loss Stagnation deg. C =
. 116 of 116 parameters shown (unfittered) Temperature Stagnation Inlet deg C ~
displayed : Show
Alphabetical Desciption | Remove Clear Al | | Same Units Use Prefered Units \
Output Window Table Header:  Z Avg
Visual Report Abbreviation:  Z Avg
Description Average compresaibiity factor (comrection for nonideal gas behavior)in pipe
"
Description of /
—
terms can be —
displayed Load Control Format. User Defaul xStream Defauit o 0K
[ Same As Parent - Save Control Format... Set as Default P Hep B cancal

= Reorder
output
using this
tool

These are
displayed
in the
output

Select
units

Figure 2.24 The Output Control window lets you customize the

output

Units for each column in the Output window can also be changed by
double-clicking the column header. This will open a window in which
you can select the units you prefer (Figure 2.25). These changes are
extended to the Output Control parameter data that is set.
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Change Units

Transient velocity at specified pipe station

Velocity
(meters/sec)
feet/zec | o oK |
kemhr Q’/o
miles/hr m s
#F Use Prefemed

Figure 2.25 The Change Units window is opened from the Output
window tabs by double-clicking the column header

Step 7. View the Graph Results

For transient analysis, the Graph Results window will usually be more
helpful than the Output window because of the more voluminous data.

> Open the Graph Results window by choosing it from the Windows
menu, clicking the Graph Results tab, by clicking "Graph Results" from
the Solution Progress window after running the model, or by pressing
Ctrl+G.

AFT xStream's Graph Guide feature, accessed by clicking on the "What
Would You Like to Do?" button located at the top right of the Graph
Results window, provides assistance by guiding you through the creation
of a "Quick and Simple" graph, or an "Advanced" graph (Figure 2.26).
You can create a graph by following the prompts on the Graph Guide, or
by manually specifying the graphing parameters on the Graph Control
tab on the Quick Access Panel, or from the "Select Graph Parameters"
icon located in the top left corner of the Graph Results Toolbar. For the
remainder of this Quick Start Guide, the Graph Guide will be hidden,
but keep in mind you can use it whenever you would like assistance in
creating a graph.

Figure 2.27 shows the Graph Results window with the Graph Control
tab selected on the Quick Access Panel.
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X
Create Graph

What
Would You
Like to Do?

. -

Quick and

»
Simple B Advanced

523 Sefings -

Figure 2.26 The Graph Guide

-
" Workspace | £4ModelData | [ Output | [ GraphResults | ®> Visusl Report | Graph List Manager
=] a E | 5 ey = - e 2 What Would You Liketo Do? || 0 & | & | 2 =
\ {z=| My Graphs Graph List
Granh Guid Manager
raph Guide
Select Graph
Parameters
/ (3 Parameters +2% Formatting >
Adjustable split bar | B Transient Fipe B Tronsient et B Profile
Select Pipe Stations: Graph These Pipes/Stations:
X Pipc | 1)
- 2 (Pipe)
Pgr_ar_'neters = |_Parameters/For
Graph Area definition area matting Area
Muti-Scenaria.. v || Cument Only
Time Units: | seconds
Time Frame: | @ All Tmes () User Spectied
Graph COntI’O| ta b Select Parameter & Add - Remove 4
| Parameter [ Units [Da
8yl Pressure Static = bar -0
i i
"New Tab" button —_— o Generde -
B x P o “ £ Graph Control
Base Scenario |[ETTEETS| 3 Overview Map [=] Add-on Modules Q“
l J

Quick Access Panel

Figure 2.27 The Graph Results window and Quick Access Panel
Graph Control tab is where various system
parameters (both steady-state and transient) can be
graphed

AFT xStream gives you the ability to create "stacked graphs". These are
graphs that are vertically aligned with each other that use the same x-
axis but with different parameters on the y-axis of each graph. This
feature is helpful when you want to look at how different parameters
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vary with time at a given position without having to create separate
graphs.

In this example, you will create stacked graphs of the Temperature
Static, Velocity, and Mach number at the exit of pipe P2 to see how
these parameters change as the blowdown proceeds.

> Access the graphing parameters by opening the Graph Control tab
on the Quick Access Panel (this tab is automatically selected when
the Graph Results window is opened). Because we are interested in
seeing how the pressures and flows in specific pipe sections respond
over time, ensure that the Transient Pipe tab is selected in the
Parameters/Formatting area on the Quick Access Panel. Alternatively,
you can open the Select Graph Parameters window by clicking on the
corresponding icon on the Graph Results Toolbar (Figure 2.27).

> Under "Select Pipe Stations" on the Transient Pipe tab, expand the
P2 pipe stations and double-click on Outlet, which is the pipe
computing station at the discharge of the blowdown pipe. Alternatively,
you can click on the right arrow button after selecting the pipe station
you want to graph to add it to the "Graph These Pipes/Stations" list.

> Verify "seconds" is selected for the Time Units and "All Times" is
selected for the Time Frame.

> In the Parameters definition area, select "Temperature Static" and
under "Units" select "deg. C" in the dropdown box to graph the
static temperature in deg. C at the pipe discharge over time.

> In order to add the stacked graphs under the static temperature
graph showing the velocity and Mach number at the outlet of pipe
P2, click the "Add" button twice, which is the green "+" icon next to
"Select Parameter". Two new rows will appear under the Parameter
definition area (Figure 2.28).

> Choose "Velocity" in the first new parameter row and select units of
"meters/s". Choose "Mach Number" for the second row.

Figure 2.28 shows the input in the Parameters/Formatting area on the
Quick Access Panel.
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ﬂ Transient Pipe HIransientht Hﬁrofile

Select Pipe Stations: Graph These Pipes/Stations:
- 1 (Pipe) P2 Outlet
=8 {Pipe)
L Tnlet
- Outlet
Other Stations <

The "Add a new
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Multi-Scenario. .. - || Current Only
Time Units: | seconds
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Figure 2.28 The Graph Control tab on the Quick Access Panel
allows you to specify the graph parameters you want
to graph in the Parameters/Formatting area

Click Generate at the bottom of the Quick Access Panel to create the
static temperature, velocity, and Mach number graphs at the pipe
discharge over the duration of the simulation.

To format the legend font size, right-click on each legend and use
the scroll bar to decrease the font size to 14 for all three graphs. Drag
the legend to the bottom right corner of the graph

To format each axis font size, right-click on each axis title and use
the scroll bar to decrease the size until the font size on each axis
appears as you want it.

Figure 2.29 shows the stacked graphs detailing the static temperature,
velocity, and the Mach number at Pipe P2 outlet over the course of 240
seconds. Here you can see that the maximum temperature at the
discharge is about 800 deg. C. Also note that the maximum temperature
in Figure 2.29 does not approach the value indicated in the Transient
Max/Min tab. This is because the Transient Pipe graph shows only the
outlet station (station 75), while the maximum temperature in pipe 2 is
reached at station 66.
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Note: The axis titles in the stacked graphs in Figure 2.29 have been
modified for clarity.

Graph Results o x
BB & Gl e = m (€ |- & 2 8 {3 What Would You Like to Do?
1000
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g
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=400
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]
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kg
o oaw
]
E 200
3
-200
1.2
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+ 0.8
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g 0.4
= 0.2
0
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Figure 2.29 The Graph Results window offers full-featured plot
generation. The static temperature, velocity, and Mach
number of Pipe P2 outlet are shown.

Further review

Further review of the graph results in Figure 2.29 shows that sonic
choking occurs after several seconds and continues for the next 130
seconds. Also note that the temperature, velocity and Mach number all
rise sharply shortly after the valve opens, with the Mach number rapidly
reaching one. After the initial rise, the temperature and velocity both
decay while the Mach number remains at one. The velocity drops
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because sonic velocity has a positive correlation with temperature, so as
the temperature decays, the velocity required for choked flow also
decreases. This relationship is important to understand when looking at
systems that encounter choking.

For the purpose of this analysis, it is also helpful to look at the
temperature and pressure of the tank over time.

Create a new graph tab by clicking the "New Tab" button which is the
green plus icon located on the bottom right, immediately below the
graph area (Figure 2.27).

Open the "Transient Jct" tab on the Graph Control tab of the Quick
Access Panel (Figure 2.30). Add the J1 (Supply Tank) Junction.

Verify "seconds" is selected in the Time Units section and "All
Times" is selected in the Time Frame section to graph the Tank
Temperature and Pressure Stagnation over the entire simulation
duration.

Click the "Add" button to add a new row under the Parameter
definition area.

Select "Tank Temperature Stagnation' and specify the units as deg.
C. For the second row, select "Tank Pressure Stagnation" and specify
the units as bar.

Click Generate at the bottom of the Quick Access Panel to display the
graph. These graphs show the tank pressure and temperature initially
decrease quickly, then decrease more slowly as time progresses. This
change in slope is due to a decreasing pressure gradient between the
tank and the atmosphere as the tank is emptied, which slows the mass
flow rate out of the tank (Figure 2.31).

Note: AFT xStream assumes all pipes are adiabatic (perfectly insulated).
Over a 240 second run time this assumption may not be accurate.
Consider this when evaluating simulation results over longer times.
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, nIransient Fipe ‘ HIFEI'ISiEHtJCt Hﬁroﬁle
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ﬂlﬁl Tank TemperatureStagnation j deg.C

Figure 2.30 Graph Parameters window for the Transient Junction
graph
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Figure 2.31 The Transient Junction graph shows how variables
within a junction change over time. The temperature
and pressure of Tank J1 over time are plotted.

Step 8. View the Visual Report

The Visual Report allows you to show text output alongside the model
schematic. This is useful to quickly show pertinent information in
relation to location in the model. The Visual Report can also animate the
transient pipe results in a color animation overlaid on the model.

> Change to the Visual Report window by choosing it from the Window
menu, clicking the Visual Report tab or by pressing Ctrl+I. The Visual
Report window allows you to integrate your text results with the graphic
layout of your pipe network. The Visual Report Control window should
open automatically when accessing the Visual Report window for the
first time. The Visual Report Control window can also be opened from
the Visual Report Toolbar or the Tools menu. Note that the parameters
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present in Visual Report Control are determined by the parameters
selected in Output Control.

> Select "Max Temperature Static" and "Min Temperature Static" in
the Pipe Transient Output area of the Visual Report Window as shown
in Figure 2.32. Click the Show button. This will generate the Visual
Report window graphic seen in Figure 2.33.

Visual Report Control - Transient Qutput Mode

Display Mode

O Input () Steady Output (@) Transient Output () Animate ‘ Iz‘ (A Automatically Refresh Visual Report After Run

Display Parameters | General Display | Show Selected FipesiJunciions | Color Map |

Max Pressure Static
Min Pressure Static
Max Mass Flowrate
Min Mass Flowrate
Max Velocity

Min Velocity

Max Temperature Static
: Min Temperature Static

ROOOoOoofd

COutput Window Table Header:  Static Temperature
Visual Report Abbreviation: T
Description Transient static temperature at specified pipe station

The features on this tab folder are specified for the transient output mode only.

Library

|u Save Options... | |!, User Defautt | |l‘~ Reset Locations ‘ |® Show |

|g Same As Parent -

ﬁ Load Options... | |2, Set as Defautt | |@ Help ‘ |m Cancel |

Figure 2.32 The Visual Report Control window selects content for
the Visual Report window

It is common for the text in the Visual Report window to overlap when
first generated. You can change this by dragging the text to a new area
to increase clarity. You can also use the Visual Report Control window
to display units in a legend to increase the clarity of the display. These
adjustments have been made in Figure 2.33. This window can be printed
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or copied to the clipboard for import into other Windows graphics
programs, saved to a file, or printed to an Adobe PDF file.

Visual Report o x
@ EE AL BT a -
) AFT xStream Model
Open Visual Base Scenario

Report Control PIPE UNITS
Temperature Static (T MxTr)=deg.C
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displayed in a .
|eg end xJz2 J3
O ............ N S DR — ¢
P1 P2
T MxTr=150 T MxTr=919
T MNnTr=-33 T MnTr=-33
Click and drag
text to
preferred
location
< >
Base Scenario F 8 120% | { } O

Figure 2.33 The Visual Report integrates results with model layout

Step 9. Examine the effect of sectioning

In AFT xStream, sectioning plays an important role in model accuracy.
Due to how the MOC operates, accuracy increases with the number of
sections you have in the model. To illustrate this, the model was re-run
with a Minimum Number of Sections Per Pipe of 6. Comparing Figure
2.31 to Figure 2.36, values such as the tank temperature and pressure for
Tank J1 remain similar with the increase in the number of sections.
However, values such as the maximum temperature reached in Pipe 2
(Figure 2.20 and Figure 2.34), changed substantially. This value
increased from 919 deg. C to 1203 deg. C. This change in the maximum
temperature indicates that the difference in sectioning has significant
implications if your interest is in the conditions in the blowdown pipe. It
should be noted that changing the Minimum Number of Sections Per
Pipe from one to six caused the computation time of the model to
increase from 5-6 minutes to 3.5 hours. Therefore, it is of critical
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importance to balance accuracy and computation time when using
AFT xStream.

&  Pipes fxial Points  Transient Output | TransientMax/Min | Heat Transfer

Max. Static Max. Static Max. Static Min. Static Min. Static Min. Static | Max. Static Max. Static Max. Static
Pipe Temperature | Temperature | Temperature | Temperature | Temperature | Temperature | Pressure Pressure Pressure
(deg. C) Time (seconds) Station (deg. C) Time (seconds) Station (bar) Time (seconds) Station
1 150.0 3.986E-03 0 -30.73 2400 0 45.00 1.993E-03 0
2 1.202.8 2974 367 -3766 2400 450 40.52 2614 0

Figure 2.34 Transient Min/Max window for modified sectioning
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Figure 2.35 Temperature, velocity, and Mach number for the
discharge of Pipe P2 with 6 sections minimum per
pipe
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Figure 2.36 Temperature and pressure stagnation for Tank J1 with
6 sections minimum per pipe
Conclusion

You have now used AFT xStream's five Primary Windows to build and
analyze a simple gas transient model.



CHAPTER 3

Gas Turbine Fuel System Example

This example looks at an instantaneous valve closure in front of the
combustion baskets in a natural gas fuel system. The objective is to
determine the maximum fluid temperature reached during the transient.

Topics covered

This example will cover the following topics:

Required knowledge

Modeling a valve closure as a transient event
Modeling a heat exchanger
Using the Scenario Manager in AFT xStream

Indicating the importance of the Estimated Maximum Temperature
During Transient

Creating animated profile graphs

This example assumes that the user has some familiarity with AFT
xStream such as placing junctions, connecting pipes, entering pipe and
junction properties, and entering transient data. Refer to the Tank
Blowdown Example in Chapter 2 for more information on these topics.
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Model file

The file listed below contains a completed version of this example and
can be located in the Examples folder as part of the AFT xStream
installation. This file can also be downloaded from the AFT xStream
help site from the Gas Turbine Fuel Example page:

e Metric - Gas Turbine Fuel System.xtr

Problem statement

The objective of this example is to evaluate the maximum temperature
that the natural gas in a turbine fuel system will reach if one of three
control valves were to instantaneously shut. The natural gas is preheated
by a heat exchanger before passing through the three control valves,
with each feeding a separate combustion basket.

As the design engineer, you are also responsible for evaluating the
sensitivity of the results to the Minimum Number of Sections Per Pipe
parameter.

Step 1. Start AFT xStream

Open AFT xStream. Click "Start Building Model".

Step 2. Build the model

A. Place the pipes and junctions

The first step is to define the pipes and junctions. In the Workspace
window, assemble the model as shown in Figure 3.1.
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Figure 3.1 Layout of gas turbine fuel system

B. Enter the pipe and junction data

The system is in place but now the input data for the pipes and junctions
needs to be entered. Enter the following data in each Pipe and Junction
Properties window.

All Pipes are Stainless Steel - ANSI, Schedule 10S, and have standard
roughness. The rest of the pipe information is as follows:
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Pipe # Size (inches) | Length (meters)
1 8 23
2 8 7.5
3 8 1.5
4 5 1.5
5 5 1.5
6 8 1.5
7 5 1.5
8 5 1.5
9 8 1.5
10 5 1.5
11 5 1.5

Because several of the pipes are the same, you can use the Global Pipe
Editing tool to speed up the process of entering the data. The Global
Pipe Editing tool allows you to apply changes to multiple pipes at the
same time. Select Global Pipe Edit either from the Edit Menu, or by
selecting the "Global Edit" dropdown on the toolbar and selecting the
"Global Pipe Edit" option. This will open the Global Pipe Edit window.
Select pipes P4, PS5, P7, P8, P10, and P11 from the list of pipes as
shown in Figure 3.2.
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Global Pipe Edit

Choose Data From:

@ Guide =3
@) Pipe Template Select Pipe Data... Click 'Select Pipe Data..."to Specify Parameters
() Existing Pipe
Al None || Invert
Pipe List Workspace || Special...
1 Fipe
12 Pipe
13 Pipe
[ 4 Pipe
[ 5 Pipe
16 Pipe
17 Pipe
[ 8 Pipe
19 Pipe
[ 10 Fipe
] 11 Pipe
B B Selected: 6of 11
"™ Apply Selections o § Cancel -:,’) Help

Figure 3.2  Global Pipe Edit window

After selecting the pipes, click the "Select Pipe Data" button. This will
open a template Pipe Properties window for entering the data to be
applied to all of the selected pipes. Fill out the data for the selected
pipes. When you have entered all of the data for the pipes, close the
Pipe Properties window by selecting OK. The Global Pipe Edit window
will now display a list of all of the parameters that may be applied to the
selected pipes. The parameters are categorized as they are displayed on
the tabs in the Pipe Properties window. For this example, you want all
of the parameters for all of the selected pipes to be updated to the
specified values. This can be accomplished by selecting the "All" button
above the list of parameters. The Global Pipe Edit window should now
appear as shown in Figure 3.3.



62 AFT xStream™ 2 Quick Start Guide

Global Pipe Edit

Choose Data From:

@ Guide >

=[] Fittings & Losses
Replace With |«

Fittings & Losses

(®) Pipe Template Select Pipe Data... Click "Select Pipe Data..."to Specify Parameters
(") Existing Pipe
Al MNone | Invert
Pipe List: Workspace || Special... Parameters to Change (Select in List): Al || None | Invert
1 Pipe =[] General Data ~
E i E!De MName Fipe
ipe
4 Pipe =[] Pipe Model
] 5 Pipe Material Stainless Steel - ANS]
(16 P?pe MNeminal Size 5inch
; E:E: Type schedule 105
Os Fipe Length 1.5 meters
10 Pipe Scaling (1D Reduction) Mane
" Pipe Friction Data Set Standard
] oughness X cm
Rough 0.001524

EI Heat Transfer

Heat Transfer Model Adiabatic at Internal Surface
Insulation Type Mane
i=I[] Design Alerts
Replace with |~ | Design Alerts (nane)
=[] Nintianal v
BB Selected: 6of 11 EE Bt
VU Apply Selections o Cancel P Help

Figure 3.3 Global Pipe Edit window with all pipe parameters

selected for updating

Apply the changes to the selected pipes by clicking the "Apply
Selections" button. AFT xStream will notify you that the changes have
been completed. Select OK. At this point, all of the changes have been
applied but not saved. If you wish to cancel all of the changes you just
implemented, you may do so by clicking Cancel on the Global Pipe Edit
window. Save the applied changes by clicking OK.

Notes: The "Guide >>" button in the Global Edit windows may be used
as a reminder of the required steps for the global edit process if needed.
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J1 - Assigned Flow

1. Name = PD Compressor

2. Elevation = 0 meters

3. Mass Flow Rate = 41400 kg/hr
4. Temperature = 21 deg. C

J2 - Heat Exchanger
In the Loss Model tab enter the following:

1. Name = Natural Gas Heater

2. Elevation = 0 meters

3. K=6.56

In the Thermal Data tab enter the following:
Steady Heat Rate = 1035 kW

J3 - Valve

1. Elevation = 0 meters
2. Kv=28650

3. Xt=03

J4 and J7 - Tee
Elevation = 0 meters

J5 - Valve
1. Name = Diffusion Gas FCV

2. Elevation = 0 meters
3. Kv=280
4. Xt=0.7

J6, J9 and J12 - Assigned Pressure

Because all of the Assigned Pressures have similar input data, the
Global Junction Edit tool could be used to input the data for all of the
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junctions at the same time. The Global Junction Edit tool works in much
the same way as the Global Pipe Edit tool.

Another tool that can be used to speed up data entry for items with the
same input data is the Copy Data From Junction tool. Enter the data for
Assigned Pressure junction J6, as listed below, by double clicking the
junction icon on the Workspace.

1. J6 Name = Combustion Basket #1
2. Elevation = 0 meters

3. Stagnation Pressure = 15.7 bar

4. Temperature = 60 deg. C

Click OK to close the junction J6 Properties window. Open the junction
J9 Properties window. Near the top of the Properties window is a drop-
down box labeled "Copy Data From Jet". This box lists all of the
Assigned Pressure junctions on the Workspace. Select junction J6 from
the list. This will open the Copy Data From Junction window, which
shows a list of all of the parameters for junction J6, and their values. By
checking the box beside a parameter, the current junction will copy the
parameter value from J6. In this case, you want all of the parameters for
J9 to be the same as J6 except for the name. Select the All button at the
top of the list to select all of the parameters, then uncheck the name
parameter, as shown in Figure 3.4.
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Copy Data From Junction & (Combustion Basket £1)
Parameters to Change (Select in List): Al More || Invert |Q¢° oK |
B[=] General Data " Cancel
1 Mame Combustion Basket #1
Elevation [ meters
=[] Pressure Madel
Pressure 15.7 bar (stagnation)
Temperature G0 deg. C
=[] Loss Coeflicients
K Factor Data Apply New K Factor Data
Pipe Elevation Deltas Apply New Fipe Elevation Deltas
I=I|+] Transient Data
First Event Undefined
Second Event Undefined
Transient Initiation Start Time
Pericdic Pressure Mot Used
First Transient Data None
Second Transient Data None
Repeat Transient Mo
Transient Special Condition  Mone
=[] Optional
Replace Wwith |+~ | Show on Workspace Mumber, Mame
Junction lcon Apply Selected Junction lcon v
= [l S

Figure 3.4

The Copy Data From Junction window

After clicking the OK button in the Copy Data From Junction window,
all of the junction J9 parameters are updated to the selected J6 parameter
values. Set the name of junction J9 to "Combustion Basket #2" and click
OK. Repeat this process for J12, giving junction J12 the name
"Combustion Basket #3".

J8 - Valve
1. Name = Premix Gas FCV #1

2. Elevation = 0 meters
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3. Kv=170
4, Xt=0.7
J10 - Branch

Elevation = 0 meters

J11 - Valve
1. Name = Premix Gas FCV #2

2. Elevation = 0 meters
3. Kv=170
4. Xt=0.7
5. On the Transient tab, enter the following data:
Time (seconds) Kv Xt
0 170 0.7
0.01 0 0.7
2 0 0.7

C. Check if the pipe and junction data is complete

> Open the List Undefined Objects window from the View Menu or the
Workspace Toolbar to verify if all pipes and junctions are specified. If
not, the incomplete pipes or junctions will be listed. If undefined objects
are present, go back to the incomplete pipes or junctions and enter the
missing data.

Step 3. Specify Analysis Setup

A. Specify the Fluid panel

> Open the Analysis Setup window by clicking Analysis Setup on the
Main Toolbar. Under the "AFT Standard" fluid option, select "Methane"
from the list and click the "Add to Model" button. Click OK.
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Note: Methane is used to model natural gas in order to minimize the run
time. If you need to model a real natural gas mixture, then instead of
using the AFT Standard fluid library, it would be better to use the NIST
REFPROP library or the optional Chempak add-on.

B. Specify the Pipe Sectioning and Output panel

> Open the Pipe Sectioning and Output panel. Set the Minimum
Number of Sections Per Pipe to 8 sections and the Estimated Maximum
Pipe Temperature During Transient to 60 deg. C.

Note: If following along in the completed model file, the Estimated
Maximum Pipe Temperature During Transient will have a different
value. This will be discussed in Steps 8 and 9.

C. Specify the Simulation Mode/Duration panel

> Open the Simulation Mode/Duration panel from the Transient
Control group. Enter the Stop Time as 2 seconds. Verify the Time
Simulation is set to Transient. Click the OK button.

Step 4. Create scenarios to model different sectioning setups

A. Create scenarios

In this model, the following three types of Sectioning cases for the
system are to be evaluated:

1. 8 Sections Minimum per Pipe
2. 4 Sections Minimum per Pipe
3. 2 Sections Minimum per Pipe

To evaluate the three cases, we will utilize the Scenario Manager to
create three scenarios for the three cases.

The Scenario Manager is a powerful tool for managing variations of a
model, referred to as scenarios. The Scenario Manager allows you to:

¢ Create, name, and organize scenarios
e Select the scenario to appear in the Workspace (the current scenario)

e Delete, copy, and rename scenarios
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e Duplicate scenarios and save them as separate models
e Review the source of a scenario's properties
e Pass changes from a scenario to its children

You will create three scenarios to model these cases. Scenarios are
created using the Scenario Manager from the Tools menu or the
Scenario Manager on the Quick Access Panel. The Quick Access Panel,
located on the right side of the Workspace area, contains the Scenario
Manager on the Scenario tab. A scenario tree displays all model
scenarios.

> Click the "Create Child" button on the Scenario Manager on the
Quick Access Panel. Name the child "8 Sections Minimum Per Pipe". A
new scenario will appear below the Base Scenario in the scenario tree.
Select the Base Scenario, create another child, and call it "4 Sections
Minimum Per Pipe". Finally, select the Base Scenario again and create a
third child called "2 Sections Minimum Per Pipe" (see Figure 3.5). Note
that the new child scenario is loaded when it is created using the
Scenario Manager on the Quick Access Panel.
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"Create Child
Scenario” button

Figure 3.5 The Scenario Manager on the Quick Access Panel

/

Scenano Manager o
2 e | B OH 4 B
@ Base Scenario
€% 8 Sections Minimum Per Pipe
e 4 Sectionz Minimum Per Pipe
i @ 2 Sections Minimum Per Pipe
Hotes
4en Scenario Properties
3 Overview Map [=] Add-on Modules O

displays the scenario tree which allows you to create
scenarios and keep them organized within the same
model file

B. Set up scenarios

Child scenarios "inherit" data from their ancestor scenarios. As long as
the data has not been modified in a child scenario, data parameters in the
child scenario will have the same value as their parent. Since the Base
Scenario already has been setup with 8 Minimum Sections Per Pipe, the

"8 Sections Minimum Per Pipe" child does not need to be modified.

4 Sections Minimum Per Pipe

Double-click the "4 Sections Minimum Per Pipe" scenario in the

scenario tree of the Scenario Manager on the Quick Access Panel. This
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will load the "4 Sections Minimum Per Pipe" scenario onto the
Workspace as the current scenario. The currently loaded scenario is
indicated in the scenario tree with a green circle with a checkmark
(Figure 3.5).

Open the Analysis Setup window from the Main Toolbar. Click on the
Pipe Sectioning and Output panel and change the Minimum Number of
Sections Per Pipe to 4 then click OK. The required input for this
scenario is now complete.

2 Sections Minimum Per Pipe

Double-click the "2 Sections Minimum Per Pipe" scenario from the
scenario tree in the Scenario Manager on the Quick Access Panel. This
will load the "2 Sections Minimum Per Pipe" scenario onto the
Workspace as the current scenario. This step can also be accomplished
by opening the Scenario Manager from the Tools menu, selecting the "2
Sections Minimum Per Pipe" scenario and clicking the "Load As
Current Scenario" button.

Open the Analysis Setup window from the Main Toolbar. Open the
Pipe Sectioning and Output panel and change the Minimum Number of
Sections Per Pipe to 2 then click OK. The required input for this
scenario is now complete.

Step 5. Run the first scenario

>

Double-click the "2 Sections Minimum Per Pipe'" scenario in the
Scenario Manager. Select "Run Model" on the toolbar. AFT xStream
will prompt you to save, then will open the Solution Progress window.
This model is estimated to run in approximately one minute, but the run
time is dependent on the speed of your computer.

Step 6. Review the results

>

Click the Output button. This will take you to the Output window,
which will display any warnings if they exist. There should be a warning
indicating that the maximum transient pipe temperature was higher than
the estimate as well as a caution that the maximum transient pipe mach
number was significantly lower than the estimate (see Figure 3.6). The
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Estimated Maximum Pipe Temperature During Transient is critical to
the calculation of transient conditions due to its necessity in the Method
of Characteristics.

The Estimated Maximum Pipe Temperature During Transient is used to
calculate the sonic velocity of the fluid, which is then used to create the
upper boundary of the characteristic grid. If the maximum temperature
during the transient exceeds the specified Estimated Maximum Pipe
Temperature During Transient and the flow is sonic, the Method of
Characteristics may have to extrapolate data, which can lead to
instability and will stop the transient solver. In this model, sonic velocity
was not reached when the temperature was higher than the estimated
maximum. However, to ensure that this model can handle sonic flow,
we will re-run the model with a higher Estimated Maximum Pipe
Temperature During Transient.

The Maximum Transient Pipe Mach Number error indicates that error
could be introduced through having a Mach Number substantially lower
than the Maximum Transient Pipe Mach Number used for the
calculation (in this case, the xStream default value of one). This caution
will be ignored in this example for simplicity.

A  General | Wamings | DesignAlerts = Applied Standards = Valve Summary = Heat Exchanger Summary

Messages
For an explanation of Wamings. click an item in this list and press F1 or search for Wamings' in the Help system.
~ WARNING
The maimum transient pipe temperature (75.20 deg. C) was higher than the estimate (80.00 deg. C). The estimated ma:amum pipe temperature should be set marginally above the maximum.
- CAUTION

Figure 3.6 The maximum transient pipe temperature exceeds
estimated maximum temperature warning indicates
that the model is at risk of instability if changes are
made

Step 7. Adjust the Pipe Sectioning panel

> Double-click "Base Scenario" in the Scenario Manager. Open the
Analysis Setup window from the Main Toolbar and select the Pipe
Sectioning and Output panel. Change the Estimated Maximum Pipe
Temperature During Transient to 80 deg. C. Click OK.
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Note: It is essential that this change is made in the Base Scenario so all
scenarios are updated.

Step 8. Re-run the model and review results

> Double-click the "8 Sections Minimum Per Pipe" scenario. Select
"Run Model" from the Analysis menu, then proceed to the Output
window. There should be a caution indicating that the maximum
transient pipe mach number was significantly lower than the estimate.
Disregard this error as discussed previously. Select the Transient
Max/Min tab (Figure 3.7). Here we can see that the maximum
temperature in the inlet lines (P5, P8, & P11) to the combustion baskets
is 72.7 deg. C and occurs in the inlet line to combustion basket 1.

#  Pipes Axial Points  Transient Output | TransientMax/Min | Heat Transfer
ity | Min. Velocity | Min. Velocity | Min. Velocity | Max. Static Max. Static Max. Static Min. Static Min. Static Min. Static
Pipe | Time (seconds) Station Temperature | Temperature | Temperature | Temperature | Temperature | Temperature
[metersisec) (deg. C) Time (seconds) Station (deg. C) Time (seconds) Station
1 ]123 18.934 0.04303 123 26.95 0.8106 123 2094 0.2350 2
2 40 20478 0.02523 40 7767 0.04303 0 58.94 0.000 1
3 8 20.328 0.02171 8 7410 0.3676 0 58.94 0.000 4
4 0 14.652 0.02693 0 73.88 0.4202 0 59.13 2.152E-03 8
5 g 16,683 5.477E-03 3 0.4306 0 58.46 0.02885 4
6 8 11.021 0.02015 2 739 0.4202 0 59.03 0.000 8
7 8 33.041 3717E-03 0 73.00 0.5078 2 58.94 0.000 8
8 8 35278 7.825E-04 0 7199 0.5297 0 58.10 0.02504 5
9 8 -5.025 0.01721 0 73.50 0.5019 0 59.14 1.565E-03 8
10 8 -8.784 0.01383 0 69.74 2.000 0 58.94 0.000 8
11 8 -16.765 0.01330 8 70.02 0.01643 0 56.37 0.01056 3
£ >

Figure 3.7  Transient Max/Min tab in the Output window

Step 9. Graph the results

Go to the Graph Results window by clicking on the Graph Results tab or
pressing Ctrl+G on the keyboard.

Create a graph that shows the temperature over time at the entrance to
Combustion Basket #1 using the following steps:

1. From the Graph Control tab on the Quick Access Panel, select the
Transient Pipe tab
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2. Select Pipe P5 and add the outlet station
Verify that the time units are set to seconds

4. 1In the Parameters definition area, select "Temperature Static" and
specify "deg. C" in the dropdown box under "Units"

5. Click the Generate button

The results (see Figure 3.8) show a maximum temperature of 72.3 deg.
C at the entrance to combustion basket #1. Note this temperature is
lower than the temperature shown on the Transient Max/min tab because
this graph is showing the outlet of pipe P5,while the maximum
temperature in pipe P5 occurs at the inlet of the pipe. The maximum
temperature for the outlet of P5 occurs at about 0.6 seconds before
returning to the previous steady state temperature of 60 deg. C after the
flow has normalized.

Graph Results o x
BBy & G e m 0 | Q |- b & 0 & What Would You Like to Do?
Temperature Static vs. Time

80
"Add Graph
to List" icon —
o //\
g &0
Z
=
bl
i
L i
[
-
=
et
5
-
o
a 20
£
o
|_
Static Temperature - P5, Sta. 8 (Outlet)
0
0 0.5 1 L5 2
Time (seconds)
B x g £ v
Base Scenaric/8 Sections Minimum per Pipe || Cautions Exist

Figure 3.8 Inlet to combustion basket #1 Temperature Static vs
Time
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To easily recreate this graph in the other scenarios or in the future, it can
be added into the Graph List Manager on the Quick Access Panel. After
generating the graph, click the "Add Graph to List" icon on the Graph
Results Toolbar (or simply right-click the graph itself and choose "Add
Graph to List"). Give the graph a name, such as "Combustion Basket #1
Temperature vs Time", then click OK. The graph will be added to the
currently selected folder in the Graph List Manager. Note that graphs
added to the Graph List Manager are not permanently saved until the
model is saved again. Also be aware that only the graph templates are
saved as opposed to the graph data.

Step 10. Animate the results

AFT xStream can animate output along pipeline paths in your model in
the Graph Results window. This feature can help you understand how
your system will respond when a transient event occurs. You can also
animate multiple graphs at the same time.

Here, you will animate the temperature static, pressure static, and
velocity along the flow path between the positive displacement
compressor and Combustion Basket #1 in order to gain an understanding
of how these hydraulic parameters respond as the control valve closes.
To animate these parameters:

1. Create a new graph tab by clicking the "New Tab" button

2. Select the Profile tab under the Graph Control tab in the Quick
Access Panel. Alternatively, you can access the Select Graph
Parameters window by clicking on the "Select Graph Parameters"
icon located at the top left of the Graph Results window.

Select pipes 1, 2, 3, 4, and 5
4. Add two additional parameters in the Parameters definition area.

Specify the three parameters as "Temperature Static", "Pressure
Static", and "Velocity"

5. Verify the Length Units are meters

6. Next to Animate Using, select "Output", and verify "seconds" is
selected next to Animation Time Units (see the following
paragraph for an explanation about this option)
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7. Verify the temperature units are "deg. C", the pressure units are
"bar", and velocity units are "meters/sec"

8. Check the Mx and Mn boxes next to the graph parameters to plot
the maximum and minimum values on the graph (see Figure 3.9)

To use the "Animate Using: Output" option for animation, which is done
here, all pipe stations need to be saved in the Pipe Sectioning and
Output panel (this was already verified in Step 5. If All is not selected,
"Output" will be grayed out).

‘ HIransient Fipe | HIransientJd | HEroﬁle
Pipes: Plat Single Path -
Al 1 Pipe A
2 Pipe
MNone 3 Fipe
et 4 Pipe
= 5 Pipe
Workspace s Fipe
) a7 Pipe
Special... Os Pipe y
Multi-scenario... = || Cumrent Only
Length Units: | meters -
Animate Using: | () None (@ Output
Animation Time Units: | seconds -
Select Parameter 4 Add ~ X Remove <4
Parameter | Units | Mx|Mn| 55| DA
0 [ Temperature Static j deg. C j O O
|w| Pressure Static j bar j OO
v Welocity j metersisec j OO

Figure 3.9

Graph Parameters for combustion basket #1 profile

Click the Generate button. Additional animation control features appear
on the Graph Results window (Figure 3.10). Press the Play button and
watch the temperature, pressure, and velocity responses move between

the maximum and minimum values. This animation can also be recorded
to a file. Click the "Add Graph to List" icon and give it a name, such as
"Combustion Basket #1 Profile".
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Note: Figure 3.10 has had the axes titles and scales modified to increase

clarity.
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Figure 3.10 Flow to combustion basket #1 profile animation

To view the animated profile

follow this link: https://bit.ly/3NIQoWC

Step 11. Run the other scenarios and graph the results

Using the Scenario Manager, load the other two scenarios and run them.

Create the same graphs you created for Steps 11 and 12 for each of the
scenarios by double-clicking on the graph names in the Graph List
Manager. This will reveal that the general behavior of the graph is the


https://bit.ly/3NIQoWC
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Conclusion

same for all 3 scenarios, but that the maximum temperature rises as the
section count is increased.

The overall maximum temperature can be found in the General section
of the Output window of each scenario. The difference between the
three sectioning counts is summarized in Table 3.1. For these cases the
maximum temperatures differ by 2.5 degrees.

Table 3.1 Summary of the maximum Static Temperature for the three
sectioning counts

Scenario Max Transient Temperature (deg. C)
8 Sections 77.7
4 Sections 76.0
2 Sections 75.2

While this example was focused on temperature, it also showed that
values such as pressure and velocity can be tracked by AFT xStream.

Additionally, this example identifies the Estimated Maximum
Temperature During Transient as a critical variable in the tabulation of
the transient results. This value sets the boundary for the characteristic
grid the Method of Characteristics uses. If sonic choking occurs at a
temperature higher than the estimated maximum, the model may not
converge. As such, this value should be conservatively high on early
runs of a model and then refined once the temperature that the transient
approaches is known.
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CHAPTER 4

High Pressure Steam - Fluid Property
Models Example

This example evaluates two turbines in a high pressure steam system
that are simultaneously valved off as a bypass line valve is opened. The
focus will be the transient behavior in the bypass line in response to
simultaneous transient events. Whether or not condensation occurs will
also be evaluated through the use of different Fluid Property Models.

Topics covered

e Using the isometric grid to create a model
e (Creating systems with multiple transients
e Evaluating the selection of a fluid property model
Required knowledge
This example assumes that the user has some familiarity with
AFT xStream such as placing junctions, connecting pipes, entering pipe

and junction properties, and entering transient data. Refer to the Tank
Blowdown Example in Chapter 2 for more information on these topics.

Model file

The file listed below contains a completed version of this example and
can be located in the Examples folder as part of the AFT xStream
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installation. This file can also be downloaded from the AFT xStream
help site from the High Pressure Steam - Fluid Property Models
Example page:

e Metric - High Pressure Steam - Fluid Property Models.xtr

Problem statement

In this problem, the inlet valves to two steam turbines in a high pressure
steam system are closed simultaneously while the bypass line is valved
open. Evaluate the maximum pressure at the turbine inlet. Additionally,
quantify the mass flow rate through the bypass valve throughout the
transient. Lastly, perform an analysis on whether two-phase flow occurs
in the bypass line by conducting a sensitivity analysis on the fluid
property model utilized.

Step 1. Start AFT xStream

Open AFT xStream. Click "Start Building Model".

Step 2. Build the model

A. Place the pipes and junctions

The next step is to define the pipes and junctions.

Isometric Drawing Mode

The previous example models were drawn using the default Pipe
Drawing Mode, 2D Freeform. AFT xStream has two additional available
drawing modes, 2D Orthogonal and Isometric. In this model, the
isometric mode is used to visually interpret pipe layout and provide a
better understanding of the system when analyzing calculated forces.

1. From the Arrange menu, select the option to Show Grid

2. Open the Arrange menu again, go to Pipe Drawing Mode, and
select Isometric

3. Place the junctions as shown in Figure 4.1
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4. Click the Pipe Drawing Tool and draw the pipes in the model as

shown. When drawing segmented pipes such as P5, a red dashed
preview line will show how the pipe will be drawn on the isometric
grid. As you are drawing a pipe, you can change the preview line
by clicking any arrow key on your keyboard or scrolling the scroll
wheel on your mouse.

Use the Rotate Icons buttons on the Workspace Toolbar, or right-
click on the junction and select the Auto-rotate option to
automatically align the junction with the connected pipes.
Alternatively, Customize Icon can be selected from the right-click
menu to manually choose an icon/orientation.

The grid can be shown or turned off in the Arrange menu, as
shown in Figure 4.2

Note: You can hold the "Alt" key while adjusting a pipe by the endpoint
to add an additional segment. This can be used with the arrow key or
mouse scroll wheel to change between different preview line options.
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Figure 4.1 The isometric layout with the grid shown
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Figure 4.2

The isometric layout with the grid turned off

B. Enter the pipe and junction data

The system is in place but now the input data for the pipes and junctions
needs to be entered. Double-click each pipe or junction and enter the
following data in the Pipe or Junction Properties window.

All pipe materials are User Specified in this model (see Figure 4.3). Use
the Absolute Roughness of Steel (0.004572 c¢m) as the Friction Model,
along with the following data:
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Pipe # Inner Diameter (cm) | Length (meters)
1 34 30.5
2 30.5 20
3 30.5 15
4 30.5 4.5
5 30.5 4.5
6 15.5 2
7 10
8 15.5 3
9 15.5 1.5
10 15.5 6
11 49 6
12 49 1.5

Pipe Properties

Name: | Pipe Downstream Junction 2 a Cancal
Copy Data From Pipe... w B dump
2 Help

Pipe Model | Fittings & Losses | Heat Transfer | Designdlerts | Optional | Motes Status

Size Length
Pipe Material: | (User Spectied) - meters ~

Inner Diamster: cm -

[ ID Reduction (Scaling):

Friction Model
Data Set
@aU o Absolute Roughness ~ Load Default
ser Specifie:
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Figure 4.3  User Specified Pipe Properties window
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J1 - Assigned Pressure

1. Name = High Pressure Steam Inlet
2. Elevation = 0 meters

3. Static Pressure = 170 bar

4. Static Temperature = 570 deg. C

J2 - Area Change

1. Elevation = 0 meters
2. Type = "Conical Transition"

3. Angle (n) = 45 Degrees

J3, J4, and J7 - Branch
Elevation = 0 meters

J5 and J6 - Assigned Flow

1. J5 Name = Turbine 1
2. J6 Name = Turbine 2
3. Elevation = 0 meters
4. Mass Flow Rate = 228600 kg/hr
5. Static Temperature =570 deg. C
6. On the Transient tab of both J5 and J6, enter the following data:
Time Static
(seconds) Mass Flow (kg/hr) Temperature
(deg. C)
0 228600 570
0.25 0 570
5 0 570
J8 - Dead End

Elevation = 0 meters
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J9 - Bend
Elevation = 0 meters

Type = Standard Elbow (knee, threaded)

J10 and J12 - Bend
Elevation = 1.5 meters

Type = Standard Elbow (knee, threaded)

J11 - Valve

1. Elevation = 1.5 meters
2. Kv=12600

3. Xt=07

4.  On the Optional tab, under Special Condition, select the radio
button for Closed.

5. On the Transient tab, enter the following data

Time (seconds) Kv Xt
0 0 0.7
2 2600 0.7
5 2600 0.7

J13 - Assigned Pressure

1. Name = Steam Bypass Outlet

2. Elevation = 0 meters

3. Static Pressure = 30 bar

4. Static Temperature = 350 deg. C

C. Check if the pipes and junctions are specified

> Click the List Undefined Objects button to see if the model is fully
defined. If it is not, the undefined pipes and junctions window will show
a list of incomplete items. If undefined objects are present, go back to
the incomplete pipes or junctions and enter the missing data.
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Step 3. Specify Analysis Setup

A. Specify Fluid panel

Open the Analysis Setup window from the Main Toolbar and open
the Fluid panel. Under the "AFT Standard" fluid option, choose "Steam"
from the list and click the "Add to Model" button. Click OK.

B. Specify the Pipe Sectioning and Output panel

Open the Pipe Sectioning and Output panel. Specify the Minimum
Number of Sections Per Pipe as 1 and the Estimated Maximum Pipe
Temperature During Transient to 600 deg. C.

C. Specify the Simulation Mode/Duration panel

Open the Simulation Mode/Duration panel from the Transient
Control group from the Analysis Setup window. Enter the Stop Time
as 5 seconds. Click the OK button.

Step 4. Run the model

>

Select "Run Model" from the Main Toolbar. The model has an
estimated run time of 5 minutes, but the run time is dependent on the
speed of your PC.

Step 5. Graph the results

>

Go to the Graph Results window. The first graph we make will show
the Static Pressure at the entrance to the steam turbines.

1. From the Graph Control tab on the Quick Access Panel, select the
Transient Pipe tab

2. Select the pipe P5 outlet station
Ensure that time units are set to seconds

4. In the Parameters definition area, select "Pressure Static" and
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specify "bar" in the dropdown box under Units
5. Click Generate

This will generate the graph shown in Figure 4.4. The pressure variation
is difficult to see using the default y-axis scale so we will adjust the
scale using the following steps:

1. Right-click the y-axis
2. Uncheck the Auto Scale box

3. Set the Minimum to 150 bar, the Maximum to 190 bar, and Major
Val to 10 (see Figure 4.5)

The graph should now match Figure 4.6. When the model contains
multiple transient events, transient pipe graphs allow the user to see the
cumulative impact of the events on system pressure. Note that the first
peak contains an oscillation, which is attributable to the opening of the
bypass valve.
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Figure 4.4  Static pressure at steam turbine 2 entrance
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Figure 4.6  Static pressure at steam turbine 2 entrance with
modified y-axis

We also will animate the profile of the bypass line temperature and
pressure in order to determine whether condensation occurs.

1. Click the "New Tab" button to create a new graph.

2. From the Graph Control tab on the Quick Access Panel, select the
Profile tab

Select pipes 6, 8, 9, and 10
4.  Verify the Length unit is set to meters

5. Next to Animate Using, verify "Output" is selected, and verify
"seconds" are the selected Animation Time Units
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6. Add a second parameter in the parameters definition area, then
specify one parameter to be "Pressure Static" and the other to be
"Temperature Static"

7. Change the Pressure Static units to " bar" and the Temperature
Static units to "deg. C"

8. Click the Generate button

9. Click the Play button to review the graph

Note: If you wish to adjust the speed of the transient in the profile, you
can use the Speed Slider in the upper right-hand corner of the Graph
Results window to speed up or slow down the animation.

Figure 4.7 is useful to determine whether or not condensation occurs in
the system, as well as understanding the cause of condensation.
Condensation can occur by a rise in pressure, a decrease in temperature,
or a combination of both. Saturation line data was added for AFT
Standard fluids in AFT xStream 2. In this model the temperatures stay
well above the saturation line at all times, showing that the steam is not
close to condensing.

It should be noted that the saturation data is limited to predicting the

presence of saturation conditions as opposed to modeling the behavior
of the multi-phase mixture.
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Figure 4.7 Bypass line animation profile

To view the animated profile, follow this link:
https://bit.ly/3GDqYre

Lastly, we shall create a graph to show the mass flow rate and the
pressure drop through the bypass valve to gain insight into how the flow
develops in the bypass line.

1. Click the "New Tab"button to add a new graph tab

2. From the Graph Control tab on the Quick Access Panel, select the
Transient Jct tab

3. In the Select Junctions section, select J11 and click the ">" arrow

4. Add a second parameter in the Select Parameters section. Specify
the parameters as "Mass Flow Rate Inlet" and "Pressure Drop
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Stagnation Total".

5. Set the units for Mass Flow Rate Inlet to "kg/hr" and Pressure Drop
Stagnation Total to "bar"

6. Click Generate

As shown in Figure 4.8, the flow rate increases and the pressure drop
decreases as the valve opens over time. While the observed trends for
mass flow rate and pressure drop are typical for a valve that is opening,
it is still worthwhile to make Transient Jct graphs when multiple
transient events occur in order to fully understand the interactions
between them.

Note: Figure 4.8 has modified axes titles and its legend removed for

clarity.
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Figure 4.8 Bypass valve mass flow rate and pressure drop
transient
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Step 6. Evaluate the effects of changing fluid property models

A. Review the results of other libraries

In addition to the AFT Standard fluid library, the model built in this
example was run using the Chempak, NIST REFPROP, and ASME
Steam libraries. Similar results to the AFT Standard Fluid run were
obtained for both the bypass valve and the turbine pressure vs time
graph, so these results are not shown below. Nevertheless, it is sensible
to run your system using different fluid property models as they have
been known to impact results. The temperature profile for the bypass
line showed more significant differences, as is shown below comparing
the results using NIST REFPROP to the AFT Standard fluid library.
ASME Steam and Chempak gave nearly identical results to NIST, and
therefore are not shown.

Note that the minimum temperature reached at J11 is 32 degrees Celsius
higher in the AFT Standard fluid library run compared to the
NIST REFPROP run.

Note: The axes of the below graphs were modified for clarity.
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Figure 4.9  Bypass line profile obtained using NIST REFPROP

B. Advice for preliminary runs

Obtaining final results from AFT xStream will require multiple
iterations. To effectively work through those iterations, we recommend
the iterative process begins with the following steps:

Step 1: Run the steady-state model

It is recommended that the first runs are completed using a simplified
version of your model in the AFT Arrow™ Steady-State Solver with
each fluid property model before considering transient conditions. This
will allow for larger issues in the model to be caught before having to
commit to Transient runs, which are more time consuming. This also
can inform the types of variables that need to be considered during
refined runs (i.e. if the AFT Arrow™ steady state runs are close to the
saturation temperature, condensation is a phenomenon that should be
monitored in subsequent runs).



Chapter 4 High Pressure Steam - Fluid Property Models Example 95

Step 2: Complete a transient run using an AFT Standard fluid
with minimal sectioning

You should then run your simplified model in the Transient Solver using
an AFT Standard fluid with minimal sectioning. This is not always
possible, such as when mixtures are present, but this step should always
be attempted if allowable. This will allow for larger issues to be caught
before committing to extended run times. Only after you are satisfied
with the model should you attempt increasing the number of sections.

C. Selection of fluid property model for final runs

A number of factors must be taken into consideration while selecting the
fluid property model for an AFT xStream model. If there are no
mixtures, and the compound is present in the AFT Standard library, it is
recommended that the AFT Standard library be the first library used.
AFT Standard has the shortest run times of the four libraries and is an
excellent choice for early runs focused on troubleshooting the model.
However, if there is a need to model mixtures, and simplifying the
system is not possible, initial runs should be conducted with

NIST REFPROP or Chempak.

NIST REFPROP and Chempak both have greater accuracy than

AFT Standard and can represent mixtures. However, both have slower
run times than AFT Standard. Chempak runs faster than NIST
REFPROP with comparable accuracy. However, Chempak is an optional
add-on while the NIST REFPROP library comes standard with

AFT xStream.

Lastly, ASME Steam provides a well-established, trustworthy source of
steam data. ASME Steam has the longest run times of the four, and it is
recommended that a high processing power computer paired with ample
time be used to run your analysis if this library is selected. If either of
those elements is unavailable, it is recommended that one of the three
other libraries be used, with the added note that NIST REFPROP is the
most similar in accuracy to ASME steam. Table 4.1 summarizes this
example's run time with the four different fluid property models. The
run times will be affected by the specifications of your computer as well
as the memory available.
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Table 4.1 shows data for runs conducted on the computers at AFT as of
publication. Additionally, Table 4.2 provides a library compatibility
chart to assist with fluid property model selection.

Table 4.1 Comparison of High Pressure Steam System run times
High Pressure Steam System Run Times
Fluid Property Model Run Time
AFT Standard - 1 Section 1 - 2 minutes
Chempak - 1 Section 8 - 10 minutes
NIST REFPROP - 1 Section 0.9 - 1.4 hours
AFT Standard - 10 Sections 1.6 - 2 hours
ASME Steam - 1 Section 3.9 - 4 hours
Table 4.2 Compatibility chart for fluid property model selection for
final runs
Fluid Model Requirements :
Library Mixtures Complex User Sp.ec1f1ed
Systems Fluids
AFT Standard v v
NIST v v
REFPROP
Chempak v 4
ASME Steam

Conclusions

The mass flow rate through the bypass line was modeled and the
cumulative effect of multiple transient events was observed.



CHAPTER 5

High Pressure Steam - Forces Example

Two turbines in a high pressure steam system are simultaneously valved
off, which causes the system to experience transient forces. This
example describes how to determine the imbalanced transient force data
for the piping system during the steam flow transient. It also evaluates
the effect of varying the time to close the valves on force magnitude.
Lastly, this example shows how to export the force results to a force file
to use in piping stress software.

Topics covered

e (alculating the forces associated with a transient event

e Using the Scenario Comparison Tool to compare scenarios

o Exporting force sets to CAESAR 1I®

Required knowledge

This example assumes that the user has some familiarity with AFT
xStream such as placing junctions, connecting pipes, entering pipe and
junction properties, and entering transient data. Refer to the Tank
Blowdown Example in Chapter 2 for more information on these topics.
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Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT xStream installation. This file can also be
downloaded from the High Pressure Steam - Forces Example topic on
the Product Help Site:

e Metric - High Pressure Steam - Forces Quick Start.xtr

Problem statement

The inlet valves to two steam turbines are shut simultaneously in a high
pressure steam system. As the design engineer, you are tasked with
completing a piping stress analysis and need to capture the magnitude of
the forces caused by the aforementioned steam transient. Additionally,
determine how the valve closure time impacts the forces. Lastly, export
the force data to CAESAR 11” to check for compliance with standards.

Step 1. Start AFT xStream

Open AFT xStream. Click the Start Building Model button.

Step 2. Open model file

For this example, we will be starting from a pre-built model file for
which setup been partially completed to save time. From either the
Startup window or the File menu, browse to the model file name shown
above. The Workspace should appear as shown in Figure 5.1.
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Figure 5.1 Model layout

Step 3. Specify the Pipe Sectioning and Output panel

> Open the Pipe Sectioning and Output panel in the Analysis Setup

window. Define the Minimum Number of Sections Per Pipe as 1 section

and the Estimated Maximum Pipe Temperature During Transient as 600
degrees C.

Step 4. Specify the Simulation Mode/Duration panel

> Open the Simulation Mode/Duration panel from the Transient

Control group. Enter the Stop Time as 1 second. Click OK to close the
Analysis Setup window.

Step 5. Specify Force Sets

We will first add one Force Set from the Workspace.



100 AFT xStream™ 2 Quick Start Guide

>

On the Workspace, right-click on pipe P2 and from the right-click
menu select "Create a Force Set with Selected Pipe." Select the Use Pipe
Information radio button and uncheck the "Include Appended Text"
option (Figure 5.2). Click Create. This will open the Force Definitions
panel of the Analysis Setup window. The Force Definitions panel should
appear as shown in Figure 5.3.

AFT xStream can only determine axial forces down a pipe in the
direction defined as forward by the force set definition. As such, AFT
xStream has no knowledge of the three-dimensional orientation of a
given force set. For example, a vertical pipe and a horizontal pipe that
both have the same force magnitude would be indistinguishable in AFT
xStream. The force set definition informs the sign of the force, with a
positive value indicating a force pushing from the start location to the
end location, and a negative value indicating the converse.

If a more robust view of the 3D orientation of the pipes is required,
directional information can be entered using the optional Force Unit
Vector columns. The Force Unit Vectors do not impact AFT xStream's
calculations, but may be useful to export the output to piping stress
analysis software as discussed in Step 11.

Note: Only single pipes can be added as a "Difference" force set type
from the Workspace. Also note that difference forces should strictly be
used between two 90 degree angle pipe fittings.
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Create Force Set

Example Force Set Name
| P2
(") Use Upstream./Downstream Junction Names

(") Use Upstream./Downstream Junction Numbers
(@) Use Pipe Information

[] Include Pipe Name

[] Include Appended Text

¥ Force Unit Vectors or Length

[+] Show Analysis Setup Force Definitions after Creation

You will be creating 1 force set.

3 Ceae | B3 Concd || Heb |

Figure 5.2  Adding force set from Workspace using the right-click

menu
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Figure 5.3  High Pressure Steam System Force input in the

Analysis Setup window
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The remaining force sets will be defined inside the Force Definitions
panel.

> Define a force set by clicking "New", selecting the Force Type (in this
example, we will be using "Difference"), entering a name, and defining
the starting and ending locations of the force set. Set up the force sets as
shown in Figure 5.4. Click OK to exit the Analysis Setup window.

Analysis Setup X
[J0  Modues v | Forces
Fluid Properties v .
= ® % x 2 - g p—
B  Pipes and Junctions v New Dupicate Delete Delete Al || Swap lodes || Import from CSV. Force Names Reoder Force Sets: | [ 3]
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{®  Transicnt Control v 1 [r2 Difierence |v| 2% 00 2v
= 2 M sl 000
i . J 00
“Force Definitions 4 [v] 0(0.0)
AFT Acrow™ Steady [v] 0(0.0) Outiet ~ |00 (686168 1A
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Eanealits: nen2 V]| | oo Amormhrc Prsare From Entormertal
O User Specfied
Ambient Pressure Units: | atm v
Collapse Al Groups B SemehsPaert - D Hep | ¢ ok | B Concel

Figure 5.4 Completed Forces panel in the Analysis Setup window

Step 6. Add child scenarios using Scenario Manager

A. Create scenarios

In this model, we will evaluate three different valve closure durations
for the system:

1. 0.1 Second Valve Closure

2. 0.25 Second Valve Closure

3. 0.5 Second Valve Closure

We will create three child scenarios to model the three cases.

> Go to the Scenario Manager on the Quick Access Panel. Create a
child scenario by either right-clicking on the Base Scenario and then
selecting Create Child. Enter the name "0.1 Second Valve Closure" in
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the Create Child Scenario window, and click OK. The new "0.1 Second
Valve Closure" scenario should now appear in the Scenario Manager on
the Quick Access Panel below the Base Scenario.

Right-click the Base Scenario in the Quick Access Panel. Create
another child and call it "0.25 Second Valve Closure". Finally, create
one more child and call it "0.5 Second Valve Closure". The child
scenarios should now be displayed as shown in Figure 5.5.

Scenano Manager o
=T =i

=-€2 Base Scenario
----- @ 0.1 Second Valve Closure
----- @ (.25 Second Valve Closure
i. ® 0.5 Second Valve Closure

Figure 5.5 Completed Scenario Manager for High Pressure
Steam - Forces

B. Define the child scenarios

Since the "0.1 Second Valve Closure" scenario uses the same transient
definitions as the base scenario, we do not need to modify it. We will set
up the remaining scenarios using the following steps:

1. Open the "0.25 Second Valve Closure" scenario by double-clicking
the name in the Scenario Manager

2. Open the Assigned Flow Properties window for Assigned Flow J10
and open the Transient tab. Enter the following data:

Time Mass Flow Static Temperature
(seconds) (kg/sec) (deg. C)
0 62.75 570
0.25 0 570
1 0 570

Enter the same Transient Data for Assigned Flow J12

4. Open the Child Scenario "0.5 Second Valve Closure" from the
Scenario Manager

5. Open the Assigned Flow Properties window for Assigned Flow J10
and open the Transient tab. Enter the following data:
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Time Mass Flow Static Temperature
(seconds) (kg/sec) (deg. C)
0 62.75 570
0.5 0 570
1 0 570

6. Enter the same Transient Data for Assigned Flow J12

Step 7. Compare child scenarios using the Scenario Comparison
Tool

The three scenarios created should be identical except for the different
transient data. To confirm the scenarios are otherwise identical, we will
use the Scenario Comparison Tool.

1. Load the "0.1 Second Valve Closure" scenario from the Scenario
Manager

2. In the Tools menu, select the Scenario Comparison Tool

3. In the Scenario Comparison - Selection window (Figure 5.6), select
"Siblings"

4. Click "Show Comparison"

5. In the Scenario Comparison Grid, set the "Item" and "Parameter"
sliders to show "Differences". Also set the "Highlight Unique
Values" slider to "Yes".

The Scenario Comparison Tool will run a comparison of all Pipe and
Junction Properties as well as the General Properties used in each
scenario and highlight any differences in the Scenario Comparison Grid.
In this model, the only highlighted differences should be for the "First
Transient Data" parameter for junctions J10 and J12 (Figure 5.7). Note
that each column in the Scenario Comparison Grid is highlighted in a
different color. This indicates that each scenario possesses a unique
value for the given parameters. Click close to exit the Scenario
Comparison Tool.
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Figure 5.7

Scenario Comparison Grid of the 3 scenarios

Step 8. Run the first scenario

> Double-click the "0.1 Second Valve Closure" child scenario in the
Scenario Manager. Ensure that all force sets are set to be applied in the
Force Definitions panel of the Analysis Setup window as shown in
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Figure 5.4. Select "Run Model" from the Analysis menu. This will open
the Solution Progress window. This model has an estimated run time of
1 minute, but the run time is dependent on the speed of your computer.

Step 9. View the results

A. Open the Forces tab

> In the Output window, click on the Forces tab. This will show the
maximum force observed in the defined force sets, as well as provide
information about how the force segments were defined.

#  Pipes  Awal Points  Transient Output = TransientMax/Min | Heat Transfer | Forces

Set | Maximum | Max Abs Start Start Pipe | End Pipe | End Fipe
MName | Absclute Time Fipe ID Station 1D Station
(M) (seconds)

1|F2 30139 0.15536 P2 0 F2 2

2 |P2 9532 0.14382 P3 0 P2 3

3 |P4 2751 0.14538 P4 0 P4 3

4 |PE-PE 30,733 0.10876 P5 0 P& 9

5 |F7 2,818 0.07657 F7 0 F7 1

Figure 5.8  Forces tab in the Output window for the "0.1 Second
Valve Closure"” scenario

B. Graph the force results

> Open the Graph Results window. We will create a graph that shows
the transient forces over time for the force sets. To do so, perform the
following steps:

1. Select the Forces tab on the Graph Control tab on the Quick Access
Panel, as shown in Figure 5.9.

Select "All" force sets to be graphed.
Verify the Force Units Primary Y is set to "N."
Verify that Time Units is set to "seconds."

Verify that the Time Frame is set to "All times."

A

Click Generate.

This should generate the graph shown in Figure 5.10.



Chapter 5 High Pressure Steam - Forces Example 107

Add the graph to the Graph List Manager by right-clicking the graph
results window and selecting "Add Graph To List...". Name the graph
"Force Sets" and click OK.

| nIransientPipe | HIransierltht | HErDﬁle | Enrces {

Force Sets: Graph Selected Force Sets:
P2
P
PE-PG
s

Multi-Scenario... ~ | |Cument Only

Force Units Primary ¥: | N -
Force Units Secondary Y: | none -
Time Units: | seconds -

Time Frame: | (® Al Times () User Specified

Figure 5.9  Graph parameters for force sets



108 AFT xStream™ 2 Quick Start Guide

Graph Results o x

BBy & HiEW e = 1 € |- & & & | What Would You Like to Do?

Force vs. Time

40000
30000 /\
20000
J\
10000 /\
S ./_"-\‘ . :.
- \\_/)/

- S~ ’/ P2
-10000 P3
/ —7 P4

Force (N)
>

-20000 P5-P6
P7
-30000
0 0.2 0.4 0.6 0.8 1
Time (seconds)
g x g 5 -
Base Scenario/0.1 Second Valve Closure || Cautions Exist

Figure 5.10 Graph for forces of the "0.1 Second Valve Closure™
scenario

Note that at t = 0 seconds, there are no force imbalances for any of the
force sets. This is expected since the sum of forces across a piping run
between two elbows equals zero in a steady state system. If a Point or
Exit type force set were used instead of a Difference type force set, then
a non-zero force may be encountered during the steady state.

Additionally, some traditional methods of analyzing force sets will not
yield the same results as AFT xStream since they may not include
friction or momentum effects in their force balances. Traditional
methods can yield significantly different results and indicate incorrect,
non-zero forces during steady state conditions.

There are two important points to be observed here:

1. AFT xStream calculates transient fluid forces. This does not
include piping, component, or fluid weight, or any other forces
external to the piping. A comprehensive analysis of pipe loading
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must separately include these items.

2. Ignoring friction and momentum force balance components will
result in force imbalances that do not exist.

Step 10. Run the other child scenarios

»  Run the other two child scenarios and load the Forces tab and the "Force
Sets" graph list item for each. The results are seen below in Figures

5.11-14.
# | Pipes Awial Points | Transient Output = Transient Max/Min | Heat Transfer | Forces
Set | Maximum | Max Abs Start | Start Pipe | End Pipe | End Pipe
MName | Absoclute Time Fipe ID Station D Station
(M) (seconds)
1|P2 12,558 02242 P2 ] F2 ]
2 |F2 4076 02219 P23 0 P2 3
3 |P4 3992 0.2153 P4 ] P4 3
4 |PE-PE 20722 0.2009 P5 0 P& 9
5 |F7 1478 0.1964 F7 0 F7 1

Figure 5.11 Forces tab in the Output window for "0.25 Second
Valve Closure"” scenario
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Figure 5.12 Graph for forces of the "0.25 Second Valve Closure™
scenario

»

Pipes = Awial Points | Transient Output = Transient Max/Min = Heat Transfer

Set Maxdimum | Max Abs Start Start Pipe | End Pipe | End Pipe
MName | Absclute Time Fipe ID | Station 1D Station
(N) [seconds)

L1 |F2 5.880.0 0.2186 P2 0 F2 2
|2 [P2 19055 02186 P3 0 F3 3
| 3 [P4 18782 0.2109 P4 0 P4 3
| 4 |P5-P6 99646 0.1986 PS5 0 P& 9
& |F7 7241 0.1953 F7 0 F7 1

Figure 5.13 Forces tab in the Output window for the "0.5 Second
Valve Closure" scenario
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Figure 5.14 Graph for forces of the "0.5 Second Valve Closure™
scenario

These figures show that the maximum force magnitude increases as the
valve closes faster. Typically, the more rapidly a change occurs, the
more severe the resulting forces are. Therefore, a utility of AFT xStream
would be to evaluate the correlation between transient event duration
(e.g., valve closing time) and the resultant force magnitudes.

Factors affecting the timing and magnitude of forces

Pipe sectioning, the selection of fluid property model, and specification
of Maximum Pipe Mach Number During Transient can have a
significant effect on the accuracy of the forces calculated by AFT
xStream. This effect was not significant in the system built within this
example. However, the results for altering each of these three parameters
are shown in Figures 5.15-17 so that you may see the impact of
changing these three parameters. Note that in Figure 5.16,

ASME Steam, Chempak, and NIST REFPROP are superimposed on
each other, indicating no meaningful difference for this case.
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Figure 5.15 Effect of sectioning on High Pressure Steam - Forces
model. All runs use the AFT Standard fluid library and
a Maximum Pipe Mach Number During Transient of 1.
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Figure 5.16 Effect of fluid property model on High Pressure Steam
- Forces model. All runs use a Minimum Number of
Sections Per Pipe of 1 and an Estimated Maximum
Pipe Mach Number During Transient of 1.
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Figure 5.17 Effect of Maximum Pipe Mach Number During
Transient on High Pressure Steam - Forces model. All
runs use the AFT Standard fluid library.

Step 11. Export CAESAR Il Force file

> Open the Output window, and click on the File menu. Select "Export
Force File..." and choose "CAESAR II® Force File." This will open the
export file window shown in Figure 5.18.
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Export CAESAR II® Force File
List of Force Sets
Force: Unit Fores
Winte To : . Length to Start . Length to End Ambient
File | ForceSetName | ForceType | StrtFipe | “Node(foet) | E™FiPS | “Nodo(fesl) | Pressure(aim) | y cicoir |\ V@t
;e 2 o zowe I
P2 Difference 3 0 3 Outlet I
P4 Difference 4 0 4 Outlet I
P5-PE Difference 5 0 6 Outlet I
P7 Difference 7 0 7 Outlet [ ]
< >
None || Invert B
Force File Time Frame Fiter Force File Data
(®) Al Times (® Wite Data to File Every Time Step
O User Specified Time Frame () Write Intermediate Data To File Every 2 Time Steps
Force File Output Units Force Analysis Type
Force: | N ~ (®) Spectum Analysis
Time Step Size (seconds): 0.00111 T () Time History Analysis
Transient Output Frequency: Every 1 Steps ime: | seconds ~
{From Transient Cortrol) 4. Export Force File...
Time Units: | seconds = Force File Data Points @ cos
Force Sets Selected: 5 Number of Data Poirts: 502 %
[] Export Unit Vector ' 4 Help

Figure 5.18 Export CAESAR II® Force File window

The force sets to include in the force file may be individually selected,
along with how frequently data points are saved. The number of data
points that will be in the file is also displayed for the given setting. This
number should not exceed the maximum number of data points allowed
for the relevant piping stress software, which in the case of CAESAR
® is 2500.

If unit vector information has been entered in the Force Definitions
panel, the Export Unit Vector option can be used to include this
information in the exported file. Similar methods to those described
above can be used to export force files to ROHR2®, TRIFLEX®, and
AutoPIPE®,

Conclusion

We created a force model to calculate the forces experienced as a result
of two simultaneous closures in a steam header. We also identified how
the length of the transient can have a significant impact on the forces a
system experiences. Finally, we discussed how to export these forces
into a force file to be used in pipe stress analysis software.
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CHAPTER 6

AFT xStream Add-on Module - PFA
Example

A frequency analysis is performed on a system with a positive
displacement compressor to determine the acoustical frequencies that
need to be evaluated for the existing piping configuration.

Topics covered

e Using the PFA module to identify natural acoustic frequencies

e Defining valid sectioning and simulation duration settings for
pulsation analysis

e Checking API-618 compliance
Required knowledge
This example assumes that the user has some familiarity with
AFT xStream such as placing junctions, connecting pipes, entering pipe

and junction properties, and entering transient data. Refer to the Tank
Blowdown Example in Chapter 2 for more information on these topics.

Model file

The file listed below contains a completed version of this example and
can be located in the Examples folder as part of the AFT xStream
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installation. This file can also be downloaded from the AFT xStream
help site from the Frequency Analysis - PFA Example page:

e Metric - Frequency Analysis PFA.xtr

Problem statement

A system's positive displacement compressor has known pulsation issues
in a section of piping with a closed valve. This issue is caused by the
system's natural frequency resonating with certain PD compressor
frequencies, resulting in severe pressure oscillations at the closed valve.
A forcing function will be placed on the PD compressor to determine
the natural acoustic frequencies, which will then be used to find the
worst-case frequencies for the system.

Step 1. Start AFT xStream

Open AFT xStream. Click the Start Building Model button.

From the Startup window under the "Activate Modules" section in the
center panel, select the PFA (Pulsation Frequency Analysis) option to
activate the PFA module. If AFT xStream is already running, choose
Activate Modules from the Tools menu, then check the box next to PFA
to activate the module on the Modules panel.

Step 2. Build the model

A. Place the pipes and junctions

The next step is to define the pipes and junctions. In the Workspace
window, assemble the model as shown in Figure 6.1.
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Figure 6.1 Layout of frequency analysis model

B. Enter the pipe and junction data

The system is in place but now we need to enter the input data for the
pipes and junctions. Enter the following data:

All Pipes are Steel - ANSI, STD (schedule 40), and have standard
roughness. The rest of the pipe information is as follows:

Pipe # Length (meters) | Size (inches)
1 8 10
2 8 10
3 8 10
4 80 16
5 3 6

J1 - Assigned Flow
1. Name = PD Compressor

2. Elevation = 3.5 meters
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3. Mass Flow Rate = 40 kg/s
4. Temperature = 38 deg. C

J2 - Valve

1. Elevation = 3.5 meters
2. Kv=2385
3. Xt=0.8

J3 - Branch
Elevation = 3.5 meters

J4 - Valve

1. Elevation = 0 meters
2. Kv=1380

3. Xt=0.6

J5 - Assigned Pressure

1. Elevation = 0 meters
2. Stagnation Pressure = 0 barG

3. Temperature = 38 deg. C

J6 - Dead End
1. Name = Closed Valve

2. Elevation = 3.5 meters

C. Check if the pipe and junction data is complete

> Turn on List Undefined Objects from the Main Toolbar to verify if all
data is entered. If it is not, the undefined pipes and junctions window
will show a list of incomplete items. If there are undefined objects, go
back to the incomplete pipes or junctions and enter the missing data.
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Step 3. Specify Analysis Setup

A. Specify the Fluid panel

> Open the Analysis Setup window and select the Fluid panel under the
Fluid Properties group. Under the "AFT Standard" fluid option, choose
"Methane" from the list and click the "Add to Model" button. Click OK.

B. Specify the Pipe Sectioning and Output panel

> Open the Pipe Sectioning and Output panel in the Pipe Sectioning
and Output group. Define the Minimum Number of Sections per Pipe as
8 sections and the Estimated Maximum Pipe Temperature During
Transient as 65 deg. C.

C. Specify the Simulation Mode/Duration panel

> Open the Simulation Mode/Duration panel in the Transient Control
group. Enter the Stop Time as 2 seconds.

D. Specify the Pulse Setup panel

> Open the Pulse Setup panel from the Pulsation Setup group. The Pulse
Setup panel is used to specify the location and magnitude of the pulse
applied to the system, as well as the parameters required to generate the
forcing function for frequency analysis.

Define the Pulsation inputs as follows (Figure 6.2):

1. Check that junction J1 is selected for the pulse to be applied at.
Note that the pulse may only be applied at Assigned Flow or
Compressor junctions.

2. For Magnitude, ensure that Automatic (Twice Steady-State Flow)
is selected.

3. Under Frequency Analysis, define the Cutoff Frequency as 200 Hz
and verify that the Minimum Number of Frequency Samples is set
to the default value of 1000.

4. Leave the Evaluate with API-618 option unchecked. This option
will be used in a later step once the acoustic frequencies have been
determined.
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Figure 6.2  Pulse Setup panel in the Analysis Setup window with
all pulsation settings defined

Now that all of the pulsation inputs are defined, look at the Pulsation
Summary at the bottom of the window. The defined Cutoff Frequency
and the Minimum Number of Frequency Samples will affect the number
of sections and the simulation duration that are required to run the
analysis. If the number of sections is insufficient, then the time step will
be too large to capture the specified Cutoff Frequency. Similarly, if the
simulation duration is too small, then the number of time steps will not
accommodate the Minimum Number of Frequency Samples.

Checking the Pulsation Summary for this example, the Minimum
Sections Required for Cutoff are 2, and the Minimum Simulation
Duration Required for Min. Samples is 0.79 seconds. Both of these
requirements are satisfied by the current model settings. The "Update
For Me" button can be used to automatically change the minimum
number of sections and/or the minimum simulation duration if they are
insufficient. Click OK to exit the Analysis Setup window.
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Step 4. Run the model

> Select "Run Model" from the Main Toolbar. This will open the
Solution Progress window. This model has an estimated run time of 5
minutes, but the run time is dependent on the speed of your PC.

Step 5. Review the frequency results

> Open the Graph Results window. The first step will be to generate a
plot of the pressure in each of the pipes to ensure that the simulation
duration was long enough for the response to stabilize. Create the
pressure graph as follows:

1. Select the Transient Pipe tab in the Graph Control tab in the Quick
Access Panel

2. Add the inlet and outlet station for each of the pipes

3. Under Select Parameter choose "Pressure Static" and verify "bar"
are the selected units

4. Click Generate

The pressure graph should appear as shown in Figure 6.3. Note that
there is a small perturbation in the pressure when the pulse is applied to
the system, though the pressure results completely stabilize by the end
of the run. If the pressure results were still changing at the end of the
run, the model should be re-run with a longer simulation duration.
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Figure 6.3  Pressure Static in each of the pipes for the frequency

analysis

Next, graph the acoustic frequency response as follows:

l.
2.

Click the "New Tab" button

Select the Frequency tab in the Graph Parameter section of the
Quick Access Panel (Figure 6.4)

Add the inlet and outlet station for each of the pipes
Verify that the pressure units are set to bar

Click Generate
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Figure 6.4  Graph Parameters section for the frequency analysis

Identify excitation frequencies to study

From the graph in Figure 6.5, there are several frequencies that produce
a large pressure response. Points on the plot with a large response
magnitude are easily identified by finding local maxima on the graph.
These maxima are the acoustic natural frequencies that are potentially
the most damaging when excited by a positive displacement compressor.
These frequencies can also be caused by equipment that contributes
large pressure drops, such as control valves.

Two natural frequencies are identified for the system based on the peaks
in the graph at roughly 27 Hz and 54 Hz. Note that the number of
sections used for the analysis may affect the location of the peaks, so it
is prudent to run the analysis with more sections to reduce uncertainty in
the results. It is also recommended to analyze frequencies near identified
peaks (for example, analyzing 52 and 56 Hz for the peak at 54 Hz) to
account for potential shifting of the frequency peaks that can result from
the assumptions made for the frequency analysis in AFT xStream.
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Figure 6.5  Acoustical frequency graph for the positive
displacement compressor system

Step 6. Determine the pressure response for AP1-618

The identified excitation frequencies can now be used to determine the
pressure response in the system caused by the pulsation at the
compressor. The pressure response can then be evaluated for compliance
with API-618.

To determine the pressure response of the excitation frequencies,
complete the following steps:

1. In the Scenario Manager, right-click on the base scenario and
choose "Create Child". Name the child scenario "27 Hz".

2. Open the Analysis Setup window and go to the Pulse Setup panel.
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Check the box to "Evaluate with API-618 and enter the Speed as
810 rpm and the Number of Heads as 2.

Enter the Time Until Steady State Pulsation as 0.15 seconds. The
method to find this value is discussed later in the example. Click
OK to close Analysis Setup.

Open the Assigned Flow Properties window for junction J1.

In the Transient tab, clear the pulse transient data by clicking Edit
Table under the transient table and choosing Clear All Data.

Check the box next to Periodic Flow. Define the Frequency as 27
1/s and the Flow Amplitude as 5 kg/sec (Figure 6.6).

Click OK to close the Properties window.
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Figure 6.6  Assigned Flow Properties window with Periodic Flow
transient applied

The model is now updated to represent the pulsation at the positive
displacement compressor that will excite the system. Run the model,
then navigate to the Output window. This scenario will run faster than
the base scenario (about 2 minutes).

In the Output window there is now a warning stating that the maximum
pressure limit for API-618 was exceeded . When the API-618 evaluation
is performed the Pulsation Summary tab is shown in the Output window
with additional information on where pressure limit violations occurred,
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and what inputs were used to calculate the API-618 pressure limits for
the scenario.

In the Graph Results window, generate a graph of the static pressure
following the same process used to create Figure 6.3. However, only
include the pipe P1 inlet and outlet station. The resulting graph is shown
in Figure 6.7. These pressure results can be used to check for
compliance with standards such as API-618.

The pressure results for the compressor outlet (Pipe P1 inlet) can also be
used to determine the Time Until Steady State Pulsation, which is one of
the inputs needed to accurately evaluate API-618. The Time Until
Steady State Pulsation is the time at which the pressure oscillations have
a consistent amplitude. In Figure 6.7 below the wave heights appear to
become consistent at about 0.25 seconds.

Note for this example the value of 0.25 seconds was given in advance to
expedite the process, but normally the user would need to run the model
once with the "Time Until Steady..." set to 0, then determine the time
input and re-run the model with the correct value.

For comparison, this model can also be run at one of the frequencies
which gave a lower amplitude, such as 14 Hz. At 14 Hz, a lower
amplitude pressure response is produced, as can be seen in Figure 6.8.

Note: The pulsation observed in this model represents a pure sine wave.
Real systems might have a different forcing function.
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Figure 6.7  Pressure Static response at 27 Hz frequenc
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Figure 6.8 Pressure Static response at 14 Hz frequency
Conclusion

The PFA add-on module for AFT xStream can be used to apply a
pressure pulse to the system in order to identify acoustic frequencies
which may result in damage. These frequencies can be used in further
pulsation analysis to determine if pulsation mitigation is required, and
what mitigation would be effective.
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CHAPTER 7

Other AFT xStream Capabilities

This Quick Start Guide necessarily omitted coverage of a number of
AFT xStream capabilities. This chapter briefly describes some of the
important capabilities not fully covered.

Microsoft Excel® data integration

AFT xStream includes enhanced Excel importing and robust Excel
exporting. An Excel spreadsheet can be used to vary selected input
parameters in multiple scenarios. Selected output can also be exported to
specified Excel sheets and cells.

Integration with other software and data standards

AFT xStream includes a number of importing and exporting capabilities.
Piping layouts and dimensional data can be imported from GIS
Shapefiles (SHP) to build a model. CAESAR II Neutral Files (CII) can
be imported into AFT xStream and EPANET Files (INP) can be both
imported and exported. Additionally, force files can be exported for use
in CAESAR II®, TRIFLEX®, ROHR2®, and AutoPIPE®.

Piping Component Files (PCF) from AutoCAD Plant 3D®, SmartPlant®,
PDS®, CADWorx®, and other software can be imported into AFT
xStream. These options are all accessed from the File menu.
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Convective heat transfer

Besides the default adiabatic heat transfer model, pipes can be modeled
using convective heat transfer, convective heat transfer with heat flux, or
convective heat transfer with heat tracing. When any of the convective
heat transfer models are selected conductive heat transfer in the fluid
and pipe walls will be accounted for both radially and axially, well as
accounting for convective heat transfer at the pipe wall surfaces.

Gas mixtures using NIST REFPROP and Chempak

NIST REFPROP and Chempak allow user-created gas mixtures using
any of the pure fluid data provided in their databases. AFT xStream is
restricted to non-reacting gas mixture calculations.

The ASME Steam Tables library

Sonic choking

The ASME Steam Tables library offers users access to fluid properties
obtained from the IAPWS Industrial Formulation 1997 for the
Thermodynamic Properties of Water and Steam (ISPWS-IF97). This
library is selected by choosing the option at the top of the Fluid panel in
the Analysis Setup window, at which point it is automatically displayed
in the Fluids in Current Model area.

AFT xStream models sonic choking in complex pipe systems and
accurately predicts the resulting choked flow rate during both the steady
state and transient simulation. In addition, AFT xStream can accurately
calculate multiple choking points in the system.

Positive displacement compressors

AFT xStream can model positive displacement compressors. Typically
PD compressors are modeled as a known flowrate over time.
Complicated periodic flowrates from multiple pistons and/or multiple
out of phase compressors can also be modeled.
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Flow and pressure control valves

AFT xStream can model flow and pressure control valves. AFT xStream
accounts for control valves which lose and regain control during the
transient.

Relief valves

The Relief Valve junction allows for a non-reclosing style relief device
to be modeled. The loss through the relief valve can be represented
using orifice sizes from API 526.

Repeat transient feature for periodic transient behavior

For elements which have periodic behavior (such as positive
displacement compressors), one cycle of data can be entered and then
specified to repeat once the cycle is finished.

Elevation changes

AFT xStream uses elevation differences between junctions to calculate
gravity driven pressure changes. These elevation driven pressure
changes can be especially important for high density gases with
moderate elevation changes, pipe systems with significant elevation
changes such as those found in overland natural gas pipelines, and gas
piping for deep mining operations.

Fitting library

AFT xStream offers a library of about 400 fitting losses which can be
added to pipes.

Design alerts

Design Alerts can be entered for pipes, then cross-plotted vs. system
behavior. A common use is maximum allowed operating pressure.
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Network libraries

Junction components and pipe materials can be saved to libraries for
later reuse. Libraries can be located on local PCs or deployed across
local or wide area networks. The Library Manager allows users to
connect to relevant libraries for their specific pipe system design.

Visual Report animations

The Visual Report window also provides the ability to animate the
transient results as a qualitative tool to visualize the behavior in a
network. One parameter can be animated using absolute values, values
relative to the steady state, or a static map of all maximum/minimum
transient values can be generated. The animation can also be recorded to
a file.
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